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About This Guide

This Novell® GroupWise® Gateway for Lotus Notes Installation and Administration Guide 
explains how to install, configure, and run the GroupWise Gateway for Lotus Notes. The guide is 
divided into the following sections: 

Chapter 1, “What Is the GroupWise Gateway for Lotus Notes?,” on page 11
Chapter 2, “Notes Gateway System Requirements,” on page 13
Chapter 3, “Installing the Notes Gateway,” on page 15
Chapter 4, “Configuring the Notes Side of the Notes Gateway,” on page 25
Chapter 5, “Configuring the GroupWise Side of the Notes Gateway,” on page 35
Chapter 6, “Running the Notes Gateway,” on page 39
Chapter 7, “Configuring the Notes Gateway,” on page 45
Chapter 8, “Monitoring the Notes Gateway,” on page 65
Chapter 9, “Optimizing the Notes Gateway,” on page 79
Chapter 10, “Using Notes Gateway Startup Switches,” on page 83
Appendix A, “Notes Gateway Error Messages,” on page 91
Appendix B, “Notes Gateway Directory Structure,” on page 99
Appendix C, “Documentation Updates,” on page 109

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 6.5 
documentation Web site (http://www.novell.com/documentation/lg/gw65):

Installation

Administration

Multi-System Administration 

Interoperability

Troubleshooting

GroupWise Windows Client User Guide

GroupWise WebAccess Client User Guide

Documentation Updates

For the most recent version of the GroupWise 6.x Gateway for Lotus Notes Installation and 
Administration Guide, visit the Novell GroupWise 6.5 documentation Web site (http://
www.novell.com/documentation/lg/gw65).
About This Guide 9
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with GroupWise. To contact us, send e-mail to proddoc@novell.com.
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1 What Is the GroupWise Gateway for Lotus 
Notes?

The GroupWise® Gateway 3.0 for Lotus Notes connects a GroupWise system and a Notes system 
by creating a link between a GroupWise domain and a Notes domain, as shown in the following 
diagram. 

Version 3.0 of the Notes Gateway provides the following capabilities:

Message exchange between users of GroupWise 5.x and 6.x and users of Lotus Notes 4.x, 5.x, 
and 6.x

Directory exchange, so that GroupWise users can be imported into the Notes Address Book 
and Notes users can be imported into the GroupWise Address Book. This enables users to 
select recipients from either system in their respective, familiar Address Books.

Directory synchronization, so that when users are added or removed, or user information is 
modified, the changes are automatically replicated between the GroupWise and Notes 
systems. This keeps the GroupWise and Notes Address Books up to date for all users.
What Is the GroupWise Gateway for Lotus Notes? 11
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2 Notes Gateway System Requirements

The Windows* machine on which you run the GroupWise® Gateway for Lotus Notes must meet 
the following system requirements.

The Windows machine where you install the Notes Gateway must meet the following additional 
requirements:

The Lotus Notes client must be installed on the Notes Gateway machine.

The Notes Gateway machine must have network access to the machine where the GroupWise 
domain directory is located.

The Notes Gateway machine must have network access to the Lotus Notes/Domino server.

Ideally, you should not install the Notes Gateway on the Notes/Domino server. Although the Notes 
Gateway can work on the same server with some versions of Notes, directory synchronization and 
exchange do not work on the same server with other versions of Notes. However, the Notes 
Gateway would still be able to exchange messages between the two systems. If you do not want 
to enable directory synchronization and exchange, you can safely run the Notes Gateway on the 
Notes/Domino server.

Hardware/Software Minimum
Requirements

Recommended
Requirements

Computer Pentium* Pentium or better

Windows NT*
(for use with 
Lotus Notes 4.x and 
5.x)

Updated with 
Service Pack 6

Updated with 
Service Pack 6 or later

Windows 2000 
(for use with 
Lotus Notes 6.0.x)

Updated with 
Service Pack 2

Updated with 
Service Pack 3 or later

Novell® ClientTM Any version Latest version

Available Disk Space 20 MB 40 MB

Available Memory 16 MB 32 MB or more

Lotus Notes/Domino* 
Server

4.0 4.5 or later

Lotus Notes Client 4.0 4.5 or later

IMPORTANT: For best results, use 
the same version for both client and 
server.
Notes Gateway System Requirements 13
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3 Installing the Notes Gateway 

Before you install the GroupWise® Gateway for Lotus Notes, both the GroupWise system and the 
Notes system should be running smoothly. Then complete the following tasks to connect the two 
systems through the Notes Gateway:

“Planning the Notes Gateway Installation” on page 15

“Meeting Installation Prerequisites” on page 20

“Installing the Notes Gateway Software” on page 20

“Installing the Notes Gateway Administrator Snap-In to ConsoleOne” on page 21

“Notes Gateway Installation Worksheet” on page 23

Planning the Notes Gateway Installation
Before installing the Notes Gateway, you should complete the planning tasks listed below. The 
planning tasks provide concepts and information you will need as you install and set up the Notes 
Gateway. You can use the “Notes Gateway Installation Worksheet” on page 23 to record your 
installation and setup information.

“Deciding Where to Install the Notes Gateway” on page 15

“Determining Where to Install the Notes Gateway Administrator Snap-In to ConsoleOne” on 
page 16

“Gathering GroupWise System Information” on page 16

“Choosing a Gateway Name” on page 16

“Deciding between Windows Application and Windows Service” on page 17

“Deciding How to Monitor the Notes Gateway” on page 17

“Determining Gateway Links between Systems” on page 19

Deciding Where to Install the Notes Gateway
In order for directory exchange and synchronization to work, you should install the Notes Gateway 
on a machine other than the Notes/Domino server. Although the Notes Gateway can work on the 
same server with some versions of Notes, it does not work on the same server with other versions 
of Notes. To ensure full functionality of the Notes Gateway with whatever version of Notes you 
have installed, plan to install the Notes Gateway on a machine other than the Notes/Domino server.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 1: Notes Gateway Location, mark whether you will install the Notes Gateway on the Notes/
Domino server or another server. 
Installing the Notes Gateway 15
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IMPORTANT: The instructions in this guide focus on the configuration where the Notes Gateway is installed 
on a machine other than the Notes/Domino server.

Determining Where to Install the Notes Gateway Administrator Snap-In to 
ConsoleOne

Notes Gateway administration is performed through ConsoleOne®, version 1.3.4 or later. When 
you install the Notes Gateway, the Gateway Administrator snap-in files are copied to a 
ConsoleOne location that you specify. The Gateway Administrator snap-in files extend the 
functionality of ConsoleOne to let you administer the Notes Gateway. 

You should install the Gateway Administrator snap-in files wherever the GroupWise 
Administrator snap-in files are already installed. Different Gateway Administrator files are 
installed depending on whether you are using the GroupWise 6.0.x or 6.5.x version of the 
GroupWise Administrator snap-ins. You can check the GroupWise Administrator snap-in version 
in ConsoleOne. Click Help > About Snap-Ins > GroupWise Administration.

You can install the Gateway Administrator snap-in files to additional locations after you have 
installed the gateway, as described in “Installing the Notes Gateway Administrator Snap-In to 
ConsoleOne” on page 21.

Gathering GroupWise System Information
The Notes Gateway will need to access the GroupWise domain where you want to link the gateway 
into your GroupWise system. You might want to create a new domain specifically for the Notes 
Gateway. This keeps Notes Gateway activity separate from domains where post offices are 
located.

Choosing a Gateway Name
When you install the Notes Gateway, a Gateway object is created in the domain where you install 
the gateway. The default gateway name is Notes.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 9: ConsoleOne Path, specify the path for the ConsoleOne location you want to use to 
administer the Notes Gateway and specify the version of the GroupWise Administrator snap-ins that 
are already in use.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 3: eDirectory Information, list the Novell® eDirectoryTM tree and context where the Domain 
object is located. 

Under Item 4: Domain Information, list the domain name and domain directory. If you want to use a 
separate domain for the Notes Gateway, create the new domain now.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 5: Gateway Name, specify the name you want to use for the Notes Gateway object.
16   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide
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When you install the Notes Gateway, a subdirectory for the gateway software and queues is 
created under the domain directory. By default, the directory name is the same as the object name. 
If you use the default object name of Notes, the gateway subdirectory will be 
domain\wpgate\notes.

Deciding between Windows Application and Windows Service
You can install the Notes Gateway as a Windows application or a Windows service. 

When you install the Notes Gateway as an application, it can be manually started by a user or it 
can be added to a user’s Startup folder so that it starts automatically when the user logs in to the 
Windows machine. When running as an application, the Notes Gateway displays a console on the 
Windows machine where you can monitor and control the gateway.

When you install the Notes Gateway as a service, it can be configured to start automatically when 
the server starts and must run under a specific Windows user account that has rights to run services. 
When running as a service, the Notes Gateway does not display a user interface on the Windows 
machine.

If you want to run the Notes Gateway as a service and if the domain it belongs to is on a NetWare® 
server, you must create an eDirectory account with a username and password that match the 
Windows user account. The eDirectory user must have Read, Write, Compare, Edit, Modify, and 
File Scan rights to the domain\wpgate\notes directory. 

Deciding How to Monitor the Notes Gateway
If you install the Notes Gateway as an application, the Notes Gateway console is displayed on the 
Windows machine where the Notes Gateway is running, which allows you to monitor the Notes 
Gateway from that location. If you install the Notes Gateway as a service, the Notes Gateway 
console is not displayed, so you must plan for another way to monitor it.

“Using the Notes Gateway Web Console” on page 18

“Using an SNMP Monitoring Program” on page 18

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 7: Gateway Installation Method, mark whether you want to install and run the Notes 
Gateway as an application or service. If you want to install it as a service, provide a username and 
password of the Windows account that will own the service. 

If the user account does not yet exist, create the user account now and give the account rights to run 
services.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 2: Domain Server Type, mark whether the domain is located on a NetWare server or a 
Windows server.

If it is located on a NetWare server, create the eDirectory account now, using the same username and 
password as the Windows account, and give the eDirectory account Read, Write, Compare, Edit, 
Modify, and File Scan rights to the domain\wpgate\notes directory. 
Installing the Notes Gateway 17
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Using the Notes Gateway Web Console

You can also monitor the Notes Gateway from its Web console. The Notes Gateway Web console 
enables you to monitor and control the Notes Gateway from any location where you have access 
to a Web browser and the Internet. This provides substantially more flexible access than the Notes 
Gateway console or an SNMP monitoring program.

Using an SNMP Monitoring Program

If desired, you can monitor the Notes Gateway from the Management and Monitoring component 
of Novell ZENworks® for Servers, ManageWise®, or any other SNMP management and 
monitoring program. When properly configured, the Notes Gateway sends SNMP traps to network 
management consoles for display along with other SNMP monitored programs.

You must enable SNMP during gateway installation. You cannot add this functionality after 
installation. In order for the option to be offered during installation, the Windows machine where 
you install the gateway must have the SNMP service installed.

The SNMP service is usually not included during the initial Windows operating system 
installation. To add or configure the SNMP service on the machine where you will install and run 
the Notes Gateway, you must be logged in as a member of the Administrator group.

To add the SNMP service to a Windows NT machine:

1 From the Control Panel, double-click Network.

2 Click Services, click Add, then select SNMP Service.

3 Follow the on-screen prompts. You will need your original Windows NT media.

You are given the opportunity to configure the SNMP service. The only required information 
for the Notes Gateway is the Trap Destination and Community Name.

4 After the installation is complete, reboot the machine.

For more information about configuring the SNMP service, see your Windows NT 
documentation. 

To add the SNMP service to a Windows 2000 machine:

1 From the Control Panel, double-click Add/Remove Programs.

2 Click Add/Remove Windows Components.

3 Select Management and Monitoring Tools.

4 Click Details, then select Simple Network Management Protocol.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 6: Web Console Information, provide a unique username and password to protect access 
to the Notes Gateway Web console. Also provide an HTTP port number for communication between 
the Notes Gateway and your browser. You might want to use a port number close to those used by the 
MTA and POA, for example, 7175.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 8: Enable SNMP?, mark whether you want to configure the Notes Gateway for SNMP.
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Determining Gateway Links between Systems
In order for the Notes Gateway to perform directory synchronization and exchange in addition to 
message exchange, you must set up a representation of the Notes system in your GroupWise 
system and a representation of your GroupWise system in your Notes system. 

In GroupWise, non-GroupWise systems are represented by non-GroupWise domains. 

In Notes, non-Notes systems are represented by foreign domains.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 12: Non-GroupWise Domain for Notes System in GroupWise, specify the name you want 
to use in GroupWise to represent the Notes system. This non-GroupWise domain will be created 
automatically the first time you start the Notes Gateway.

NOTES GATEWAY INSTALLATION WORKSHEET

Under Item 10: Foreign Domain for GroupWise System in Notes, specify the name you want to use in 
Notes to represent the GroupWise system.

Under Item 11: Notes/Domino Server Access Information, specify the information that the Notes 
Gateway will need in order to access the Notes system:

Notes/Domino Server: Specify the fully qualified name of the Notes/Domino server (hostname/
notes_domain) that will route messages through the Notes gateway.

Notes Administrator: Specify the name of a Notes user that has Manager rights to the Notes public 
Address Book and other Notes databases.

Administrator Password: Specify (or know) the password for the Notes/Domino Administrator 
program.

Certifier Server: Specify the fully qualified name of the Notes/Domino server (hostname/
notes_domain where new Notes users are registered.

Certifier Password: Specify (or know) the password required to create new Notes users.

User for the Notes Gateway: Specify a user that the Notes Gateway can use to log into the Notes/
Domino server and access the Notes public Address Book. Notes users need a first name, middle 
initial, and last name. If you do not want to user the account of a regular Notes user, you could 
create a user named "Gateway 4 Notes" or "Gateway 2 GroupWise."

If the user you want the Notes Gateway to log in as does not yet exist, create that user in your Notes 
system before you install the Notes Gateway.

User Password: Choose a password for the Notes Gateway user account.

Notes Gateway Mail File: Specify the name of the mail file used for communication between the 
Notes system and the GroupWise system, for example, notesgateway. The file will be created when 
you start the Notes Gateway and will have a .nsf extension appended to it (for example, 
notesgateway.nsf).
Installing the Notes Gateway 19
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Meeting Installation Prerequisites
After you have gathered the information that the Notes Gateway Installation program will request 
and have planned the information you will need to configure the Notes Gateway after installation, 
make sure that the Windows machine where you will install the Notes Gateway (worksheet item 
1) meets the system requirements listed in Chapter 2, “Notes Gateway System Requirements,” on 
page 13.

1 Make sure that the Novell ClientTM is installed.

The Installation program creates a Gateway object in eDirectory. The Novell Client is 
required to access eDirectory. If necessary, you can download the Novell Client from the 
Novell Product Downloads site (http://download.novell.com/filedist/pages/
PublicSearch.jsp).

2 Make sure that the Notes client is installed.

The Notes Gateway uses certain Notes client capabilities to communicate with the Notes/
Domino server.

3 Log in to the server where the domain directory resides and map a drive to the domain 
directory (worksheet item 4). 

The Installation program creates domain subdirectories and copies Notes Gateway files to the 
subdirectories. This requires full file system rights to the domain directory. 

4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where the Domain 
object resides (worksheet item 3).

The Installation program creates a Gateway object under the Domain object.

5 Continue with “Installing the Notes Gateway Software” on page 20.

Installing the Notes Gateway Software
1 Download the GroupWise Gateway for Lotus Notes from the Novell Product Downloads site 

(http://download.novell.com/filedist/pages/PublicSearch.jsp) into an empty directory.

2 Run setuplngw.exe to extract the Notes Gateway files and start the Notes Gateway Installation 
program.
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3 Click Next to view the license agreement, then click Accept to accept the license agreement.

4 Select GroupWise Gateway for Lotus Notes, then click Next.

5 Follow the prompts, using the information from items 2 through 9 on the “Notes Gateway 
Installation Worksheet” on page 23 to install the Notes Gateway
IMPORTANT: Do not start the Notes Gateway after installation.

6 Continue with “Configuring the Notes Side of the Notes Gateway” on page 25.

Installing the Notes Gateway Administrator Snap-In to ConsoleOne
After you have installed the Notes Gateway, you can install the Notes Gateway Administrator 
snap-in to Console One to additional locations as needed.

1 Make sure that no one is running ConsoleOne from the location where you want to install the 
Notes Gateway Administrator snap-in.

2 At the workstation where you want to install the Notes Gateway Administrator snap-in to 
ConsoleOne, run setuplngw.exe to start the Notes Gateway Installation program.

3 Click Next to view the license agreement, then click Accept to accept the license agreement.
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4 Select Gateway Administrator Snap-Ins for ConsoleOne, then click Next.

5 Specify the path to a ConsoleOne installation where you want to install the Notes Gateway 
Administrator snap-in.

6 Select the version of the GroupWise Administrator snap-ins that are already in use for your 
GroupWise system.

7 Click Next to continue with the installation.
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Notes Gateway Installation Worksheet

Item Explanation

1) Notes Gateway Location:

Notes/Domino server

Other server (recommended)

Mark where you will install the Notes Gateway. You should plan to install the 
Notes Gateway on a machine other than the Notes/Domino server if you will 
enable directory exchange and synchronization. See “Deciding Where to Install 
the Notes Gateway” on page 15.

2) Domain Server Type:

NetWare

Windows

Mark the platform of the machine where the gateway’s domain is located. See 
“Gathering GroupWise System Information” on page 16.

3) eDirectory Information:

Tree

Domain Object Context

Specify the eDirectory tree and context where the Domain object is located. The 
Notes Gateway object will be created in the Domain object. See “Gathering 
GroupWise System Information” on page 16

4) GroupWise Domain Information:

Domain Name

Domain Directory

Specify the domain name and directory. The Notes Gateway will be installed in a 
subdirectory under the domain. See “Gathering GroupWise System Information” 
on page 16

5) Gateway Information:

Gateway Object Name

Gateway Directory

Specify the name of the Notes Gateway object and the subdirectory in the domain 
where the Notes Gateway software will be installed. The default is Notes. See 
“Choosing a Gateway Name” on page 16

6) Web Console Information:

Username

Password

HTTP Port

Specify the information required to enable the Notes Gateway Web console. See 
“Deciding How to Monitor the Notes Gateway” on page 17.

7) Gateway Installation Method:

Application

Service

User:
Password:

Mark whether you want to install the Notes Gateway as a Windows application or 
an Windows service. See “Deciding between Windows Application and Windows 
Service” on page 17. If you want to install it as a service, provide a username and 
password of the Windows account that will own the service. 

8) Enable SNMP?

Yes

No

Mark whether you want to enable SNMP. See “Deciding How to Monitor the Notes 
Gateway” on page 17.

9) Install Gateway Administrator Snap-In to 
ConsoleOne?

Yes

ConsoleOne Path:

GroupWise Administrator Snap-In 
Version: 6.0.x or 6.5.x

No

Mark whether you want to install the Notes Gateway Administrator snap-in to 
ConsoleOne at the same time when you install the Notes Gateway. If you do, 
record the path where ConsoleOne and the GroupWise Administrator snap-ins to 
ConsoleOne are currently installed, along with the version of the GroupWise 
Administrator snap-ins. See “Determining Where to Install the Notes Gateway 
Administrator Snap-In to ConsoleOne” on page 16.
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10) Foreign Domain Representing 
GroupWise System in Notes:

Specify the name you want to use in the Notes system to represent the 
GroupWise system. See “Determining Gateway Links between Systems” on 
page 19

11) Notes/Domino Server Access 
Information:

Notes/Domino Server

Notes Administrator

Administrator Password

Notes Certifier Server

Certifier Password

Username for Notes Gateway

Gateway User Password

Notes Gateway Mail File

Specify the information you will need in order to configure the Notes system to 
allow the Notes Gateway to access it. See “Determining Gateway Links between 
Systems” on page 19.

12) Non-GroupWise Domain Representing 
Notes System in GroupWise:

Specify the name you want to use in the GroupWise system to represent the 
Notes system. See “Determining Gateway Links between Systems” on page 19

Item Explanation
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4 Configuring the Notes Side of the Notes 
Gateway

After you install the Notes Gateway software but before you start the Notes Gateway for the first 
time, you must prepare your Notes system to link to your GroupWise® system:

“Adding the Notes Software Directory to the Path Variable” on page 25

“Adding the GroupWise Address Book to Notes” on page 25

“Defining the GroupWise System As a Notes Foreign Domain” on page 26

“Registering the Notes Gateway As a Notes User” on page 28

“Setting Up Server and Database Access for the Notes Gateway User” on page 30

“Starting the Notes Client on the Notes Gateway Machine” on page 34

Adding the Notes Software Directory to the Path Variable
The Notes Gateway needs to be able to locate the Notes software directory. Therefore, you must 
add the Notes software directory to the path variable on the machine where the Gateway runs.

1 Right-click My Computer, then click Properties.

2 Click Environment.

3 In the User Variables for Administrator list, add the Notes software directory (typically 
c:\lotus\notes) to the end of the path variable value.

4 Click Set, then click OK.

Adding the GroupWise Address Book to Notes
The first time you start the Notes Gateway, it creates a secondary Address Book file (wpnames.nsf) 
on the Notes/Domino server. This file contains all GroupWise users listed in the GroupWise 
Address Book and enables Notes to resolve addresses and correctly route messages addressed to 
GroupWise users through the gateway. 

In order for Notes to read from the wpnames.nsf file, you must list the wpnames.nsf file in the 
Names section of the notes.ini file in the \lotus\notes\data directory for Lotus Notes 4.x or the 
\lotus\domino\data directory for Lotus Notes 5.x and 6.x.

1 From the Notes/Domino server, use a text editor to open the notes.ini file. 

2 Search for the Names= line.

If the notes.ini file already has a Names= line, each filename that follows Names= represents 
an Address Book that Notes will search when it is verifying recipient names in mail messages. 
The first Address Book in the list is the public Address Book (typically names.nsf). Additional 
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Address Books are searched in the order in which they appear in this line. If there is no 
Names= line, then Notes searches only the Notes public Address Book (names.nsf).

3 If there is no Names= line in your notes.ini file, create one. 

The location of the Names= line is not important; you can place the line anywhere within the 
notes.ini file. Use the following format:

Names=names,wpnames

4 If the notes.ini file already has a Names= line, add wpnames at the end of the list of Address 
Books.

Each filename must be separated by a comma (,). Use the following format:

Names=names,addrbook1,addrbook2,...,addrbookn,wpnames

5 Save the notes.ini file and exit the text editor.

You do not need to restart the Notes/Domino server in order for this change to be put into 
effect.

6 Continue with “Defining the GroupWise System As a Notes Foreign Domain” on page 26.

Defining the GroupWise System As a Notes Foreign Domain
In order for messages to be routed between the Notes and GroupWise systems, you must define 
the GroupWise system as a foreign domain in the Notes public Address Book.

1 Start the Notes/Domino Administrator as a user with write access to the Notes public Address 
Book (worksheet item 11).

2 Open the Notes public Address Book:

2a Click File > Database > Open.

2b In the Server field, select the Notes domain where you want to open the public Address 
Book.

2c In the Database field, select the Address Book for that domain.

2d Click Open.

3 Click Create > Server > Domain.
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4 Leave Foreign as the default domain type, then fill in the following fields:

Foreign Domain Name: Specify a name for the GroupWise system (worksheet item 10). This 
name must be unique in the Notes system. 

Domain Description: Optionally, provide descriptive details about the GroupWise domain.

5 Click Mail Information.

6 Fill in the following fields:

Gateway Server Name: Specify the fully qualified name of the Notes/Domino server that 
will route messages to the Notes Gateway (worksheet item 11).

Gateway Mail File Name: Specify the name of the mail file (worksheet item 11) through 
which communication between the Notes and GroupWise systems will occur. Do not specify 
an extension; the .nsf extension is automatically appended.

7 Click Restrictions.

8 As needed for your system, fill in the following fields:
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Allow Mail Only from Domains: This is a Lotus Notes feature that does not affect the 
operation of the Notes Gateway. For more information, see your Lotus Notes administration 
documentation.

Deny Mail from Domains: This is a Lotus Notes feature that does not affect the operation of 
the Notes Gateway. For more information, see your Lotus Notes administration 
documentation.

9 Click Save and Close.

10 Unless you are planning to run the Notes Gateway on the Notes/Domino server (not 
recommended), continue with “Registering the Notes Gateway As a Notes User” on page 28.

or

If you must install the Notes Gateway on the Notes/Domino server, skip to Chapter 5, 
“Configuring the GroupWise Side of the Notes Gateway,” on page 35.

Registering the Notes Gateway As a Notes User
Because you will run the Notes Gateway on a machine other than the Notes/Domino server, you 
must register the gateway as a Notes user so that it can log in to the Notes/Domino server.

1 Start the Notes/Domino Administrator as a user with write access to the Notes public Address 
Book.

2 On the Servers menu in the Notes/Domino Administrator, select the Notes/Domino server 
where you will register the Notes Gateway as a Notes user.

3 On the Tools menu of the People and Groups page, click People.

4 Click Register.

5 Specify the Notes certifier password, then click OK.
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6 In the upper right corner of the Register Person dialog box, click Registration Server, select 
the Notes certifier server (worksheet item 11), then click OK to return to the Register Person 
dialog box.

7 Fill in the First Name, Middle Initial, Last Name, and Password fields (worksheet item 11). 

8 Click Add Person to add the user to the registration queue at the bottom of the Register Person 
dialog box.

9 Select Advanced, then click Mail.

10 Click Mail Server, select the Notes/Domino server that the Notes Gateway will communicate 
with (worksheet item 11), then click OK. 

The Notes Gateway user's Mail Server must be the same Notes/Domino server that you 
specified in the Gateway Server field when defining the GroupWise system as a Notes foreign 
domain in “Defining the GroupWise System As a Notes Foreign Domain” on page 26.
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11 Click Register to save the information.

12 Continue with “Setting Up Server and Database Access for the Notes Gateway User” on 
page 30

Setting Up Server and Database Access for the Notes Gateway 
User

Because you will run the Notes Gateway on a machine other than the Notes/Domino server, the 
user you just created in “Registering the Notes Gateway As a Notes User” on page 28 needs 
appropriate access to the Notes/Domino server and Notes databases. 

“Providing Access to the Notes/Domino Server” on page 30

“Providing Access to Notes Databases” on page 32

Providing Access to the Notes/Domino Server
When you start the Notes Gateway for the first time, it creates a Notes secondary Address Book 
(wpnames.nsf) on the Notes/Domino server that contains the addressing information from the 
GroupWise Address Book. It also creates a gateway mail file (notesgateway.nsf) that is used for 
communication between the two systems. You need to provide the Notes Gateway user with the 
type of access it needs to perform these tasks. 

1 Run the Notes/Domino Administrator as a user with Manager access to Notes databases 
(worksheet item 11).

2 Open the Notes public Address Book:

2a Click File > Database > Open.

2b In the Server field, select the Notes domain where you want to open the public Address 
Book.

2c In the Database field, select the Address Book for that domain.

2d Click Open.

3 On the Servers menu, select the Notes/Domino server that will communicate with the Notes 
Gateway.
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4 On the Server Tools menu, select Server, then select Current Server Document.

5 Click Edit Server.

6 In the Administrator field, click the drop-down list.

7 Select the Notes Gateway user (worksheet item 11), click Add, then click OK.

8 Click Security.
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9 In the Create New Databases field, click the drop-down list.

10 Select the Notes Gateway user (worksheet item 11), click Add, then click OK.

The Notes Gateway creates the wpnames.nsf file and the gateway mail file one time only. This 
means that you can change the access rights of the Notes Gateway user after these databases 
have been created.

11 Click Save and Close. 

12 Continue with “Providing Access to Notes Databases” on page 32

Providing Access to Notes Databases
During operation, the Notes Gateway requires access to various Notes databases that already exist 
in your Notes system. Ensure that the gateway has the required access to the following Notes 
databases:

Providing Access Rights to the Public Address Book

1 In the Notes/Domino Administrator, open the Notes public Address Book:

1a Click File > Database > Open.

Database Access Description

names.nsf Editor or Manager The Notes public Address Book. For instructions to set 
rights, see “Providing Access Rights to the Public Address 
Book” on page 32

wpnames.nsf Manager or Editor The GroupWise secondary Address Book containing all 
GroupWise users; you will not be able to grant this access 
until after the database has been created or you have 
copied it from the domain\wpgate\notes directory. 

notesgateway.nsf Manager or Editor The gateway mail file you specified in the Gateway Mail File 
Name field (worksheet item 11) when defining the 
GroupWise system as a Notes foreign domain. See 
“Defining the GroupWise System As a Notes Foreign 
Domain” on page 26.
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1b In the Server field, select the Notes domain where you want to open the public Address 
Book.

1c In the Database field, select the Address Book for that domain.

1d Click Open.

2 Click File > Database > Access Control to display the Access Control List.

3 Click Add.

4 Click the Person icon, select the Notes Gateway user (worksheet item 11), click Add, then 
click OK.

5 From the User Type drop-down list in the Access Control List, select Person.

6 From the Access drop-down list, select Manager or Editor.

7 Click OK. 

8 Continue with “Starting the Notes Client on the Notes Gateway Machine” on page 34
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Starting the Notes Client on the Notes Gateway Machine
On the Notes Gateway machine, start the Notes client as the Notes Gateway user.

This updates the local notes.ini file on the Notes Gateway machine from that version of the 
notes.ini file on the Notes/Domain server that you updated in “Adding the GroupWise Address 
Book to Notes” on page 25.

Depending on the configuration of your Notes system, you might need to export the Notes user ID 
file for the Notes Gateway user that was set up in “Registering the Notes Gateway As a Notes 
User” on page 28 from the Notes/Domino Administrator and copy it to the Windows machine 
where the Notes Gateway will run before you can start the Notes client. You might need assistance 
from the Notes system administrator the first time you start the Notes client for the Notes Gateway 
user.

Continue with Chapter 5, “Configuring the GroupWise Side of the Notes Gateway,” on page 35.
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5 Configuring the GroupWise Side of the Notes 
Gateway

After you have configured the Notes side of the gateway, you must configure the GroupWise® side 
of the gateway by configuring the Notes Gateway object in ConsoleOne®.

“Providing Gateway Information” on page 35

“Setting Required Parameters” on page 36

Providing Gateway Information
1 In ConsoleOne, browse to and select the domain where you installed the Notes Gateway 

(worksheet item 4).

2 Right-click the Notes Gateway object, then click Properties.

3 Fill in the following fields on the Identification page:

Description: This field is optional. If desired, provide any descriptive information about the 
gateway.

Subdirectory: Displays the name of the Notes Gateway root directory specified during 
installation. The default is Notes.
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Time Zone: Displays the time zone of the domain where the gateway is installed.

Database Version: Select 5.0 if you have installed the Notes Gateway in a GroupWise 5.x 
system. Select 6 if you have installed the gateway in a GroupWise 6.x system.

Platform: Displays Windows as the default platform.

Gateway Type: Defaults to Notes.

Gateway Alias Type: Specify Notes.

Foreign ID: Specify the name of the foreign domain you created in the Notes public Address 
Book to represent the GroupWise system (worksheet item 10), as described in “Defining the 
GroupWise System As a Notes Foreign Domain” on page 26.

4 Click Apply to save the gateway information.

5 Continue with “Setting Required Parameters” on page 36.

Setting Required Parameters
1 Click Required Parameters to display the Required Parameters page.

2 Fill in the following fields: 

GroupWise Foreign Domain:  Specify the name of the non-GroupWise domain (worksheet 
item 12) that you want to create in your GroupWise system to represent the Notes system (for 
example, NotesSystem).

When you first start the Notes Gateway, the non-GroupWise (NotesSystem) domain will be 
created automatically. Under the non-GroupWise (NotesSystem) domain, an external post 
office will be created for each Notes domain and given the same name as the corresponding 
Notes domain. If you enable directory exchange and synchronization, as described in 
“Enabling Directory Synchronization and Exchange” on page 45, Notes users will be added 
to these external post offices as external GroupWise users.

After the non-GroupWise (NotesSystem) domain is created, you can use the GroupWise View 
by expanding the GroupWise System object in ConsoleOne to view the external domain, post 
offices, and users that represent the Notes system in your GroupWise system
36   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
Notes ID Password: Specify the password for the Notes user registered for the gateway 
(worksheet item 11), as set up in “Registering the Notes Gateway As a Notes User” on 
page 28. 

3 Click OK to save the information about the Notes system in the GroupWise system.

You have now provided sufficient configuration information to start the Notes Gateway.

4 Continue with “Running the Notes Gateway” on page 39.
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6 Running the Notes Gateway

After you have installed the Notes Gateway software and configured both sides of the gateway, 
you are ready to start the gateway.

“Starting the Notes Gateway” on page 39

“Acquainting E-Mail Users with the Notes Gateway” on page 41

“Stopping the Notes Gateway” on page 42

“Uninstalling the Notes Gateway” on page 42

After the Notes Gateway has started successful, continue with Chapter 7, “Configuring the Notes 
Gateway,” on page 45

Starting the Notes Gateway
Before you start the Notes Gateway, make sure that it has network access to the following 
locations:

The GroupWise® domain directory and subdirectories where you installed the gateway files. 
The gateway requires Read, Write, Create, Erase, Modify, and File Scan rights.

The Notes/Domino server. If you installed the Notes Gateway on a server other than the 
Notes/Domino server (the recommended configuration), you should have already provided 
access when you configured the Notes side of the gateway, as described in “Setting Up Server 
and Database Access for the Notes Gateway User” on page 30

Make sure that the Notes client is running on the Notes Gateway machine, then follow the 
instructions for the installation method you chose for the Notes Gateway (worksheet item 7):

“Starting the Notes Gateway As a Windows Application” on page 40

“Starting the Notes Gateway As a Windows Service” on page 40
IMPORTANT: After you start the gateway, stop and then start the MTAs in the GroupWise system. This 
establishes the links to the non-GroupWise domain that represents the Notes system.
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Starting the Notes Gateway As a Windows Application
1 At the Windows machine where you installed the Notes Gateway, click Start > Programs.

2 Click GroupWise Notes Gateway > Notes > GroupWise Notes Gateway. 

When running as an application, the Notes Gateway console appears on the machine while it 
is running. For instructions on interpreting the information displayed on the Notes Gateway 
console, and for information about other monitoring alternatives, see Chapter 8, “Monitoring 
the Notes Gateway,” on page 65.

3 Stop and then start the MTAs in the GroupWise system.

This establishes the links to the non-GroupWise domain that represents the Notes system.

4 After the Notes Gateway has started successfully and the links between systems have been 
established., continue with Chapter 7, “Configuring the Notes Gateway,” on page 45.

Starting the Notes Gateway As a Windows Service
1 At the Windows machine where you installed the Notes Gateway, click Start > Settings > 

Control Panel.

2 Double-click Services.

In the alphabetical list of services, the name of the Notes Gateway service starts with the name 
of the domain where the gateway is installed, followed by the name of the gateway itself, 
followed by Service. For example, if the domain is named Connector and the gateway is 
named Notes, then the name of the service would be ConnectorNotesService.

3 Select the gateway service, then click Start.

When running as a service, the Notes Gateway does not have a console on the machine where 
it is running. However, you can monitor it in other ways, as described in Chapter 8, 
“Monitoring the Notes Gateway,” on page 65.

4 Stop and then start the MTAs in the GroupWise system.

This establishes the links to the non-GroupWise domain that represents the Notes system.

5 After the Notes Gateway has started successfully and the links between systems have been 
established, continue with Chapter 7, “Configuring the Notes Gateway,” on page 45.
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Acquainting E-Mail Users with the Notes Gateway
After you have started the Notes Gateway, GroupWise users and Notes users need only the 
following information in order to start using the gateway immediately:

“Addressing Messages” on page 41

“Understanding What GroupWise Send Options Are Available through the Gateway” on 
page 41

Addressing Messages
If you have set up directory synchronization and exchange, as described in “Enabling Directory 
Synchronization and Exchange” on page 45, GroupWise users can select Notes users from the 
GroupWise Address Book and Notes users can select GroupWise users from a Notes version of 
the GroupWise Address Book.

If you have not set up directory synchronization and exchange, you should explain to GroupWise 
users how to add Notes users to their personal address books, as described in “Adding Individual 
Notes Users to Personal Address Books” on page 50. You should also explain to both GroupWise 
users and Notes users how to manually type addresses in the To field of messages.

For more information, see “Using Explicit Addressing” on page 50.

Understanding What GroupWise Send Options Are Available through the Gateway
GroupWise users can use some, but not all, GroupWise send options through the Notes Gateway. 
The following GroupWise send options are supported:

Priority (high, normal, low)

Classification (normal, proprietary, confidential, secret, top secret, for your eyes only)

Reply Requested (when convenient or within x days)

Delay Delivery (deliver item after x days)

Notify Recipients (if enabled as described in “Enabling Message Status for Sent Items” on 
page 62)

The following GroupWise send options are not supported:

GroupWise to Notes Syntax:
gateway_name:notes_domain.recipient's_short_name
gateway_name:"recipient's_short_name@notes_domain"

Examples:
Notes:Provo.SJones
Notes:"SJones@Provo"

Notes to GroupWise Syntax:
domain.post_office.userID@foreign_domain
userID@foreign_domain

Examples:
Corporate.Marketing.LTanaka@GroupWise
LTanaka@GroupWise
Running the Notes Gateway 41



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
Expiration Date (after x days)

Auto-Delete (when the last recipient has deleted the message)

Conceal Subject

Require Password to Complete Routed Item

Sign Digitally

Encrypt for Recipients

Stopping the Notes Gateway
Occasionally, it might be necessary to stop the gateway to perform maintenance on the Windows 
machine or for some other purpose. When you stop the gateway, any messages being sent from 
GroupWise users are queued in one of the domain\wpgate\notes\wpcsout\ngaxxxx\0-7 directories. 
Messages sent from Notes users are moved to gateway’s mail file configured in the Notes/Domino 
Administrator, as described in “Defining the GroupWise System As a Notes Foreign Domain” on 
page 26. The messages waiting in each system are processed as soon as the gateway is started 
again.

Follow the instructions for the installation option you chose for the Notes Gateway:

“Stopping the Notes Gateway If It Is Running As an Application” on page 42

“Stopping the Notes Gateway If It Is Running As a Service” on page 42

Stopping the Notes Gateway If It Is Running As an Application
1 At the Notes Gateway console, click File > Exit.

or

Press F7.

2 Click Yes to stop the gateway.

Stopping the Notes Gateway If It Is Running As a Service
1 At the Notes Gateway console, click Start > Settings > Control Panel.

2 Double-click Services.

3 Select the Notes Gateway service, then click Stop.

Recall that the Notes Gateway Service is named after the domain and gateway.

Uninstalling the Notes Gateway
If you need to remove the Notes Gateway from the machine where you installed it, follow the 
instructions for the installation option you chose when installing the Notes Gateway:

“Uninstalling the Notes Gateway As an Application” on page 43

“Uninstalling the Notes Gateway As a Service” on page 43
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Uninstalling the Notes Gateway As an Application
1 At the Windows machine where you installed the Notes Gateway, click Start > Programs > 

GroupWise Notes Gateway > Notes > Uninstall.

or

Follow the steps provided in “Uninstalling the Notes Gateway As a Service” on page 43.

Uninstalling the Notes Gateway As a Service
1 At the Windows machine where you installed the Notes Gateway, click Start > Settings > 

Control Panel.

2 Double-click Add/Remove Programs, select domain.gateway (Notes Gateway), then click 
OK.

3 If a message informs you that some files could not be deleted, delete the domain\wpgate\notes 
directory.

4 In ConsoleOne, verify that the Notes Gateway object has been deleted from the domain.
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7 Configuring the Notes Gateway

After the Notes Gateway is up and running between the GroupWise® system and the Notes system, 
there are a variety of ways to refine its configuration to meet the specific needs of your e-mail 
users.

“Enabling Directory Synchronization and Exchange” on page 45

“Configuring Addressing” on page 47

“Controlling Gateway Access” on page 51

“Setting Up Accounting” on page 58

“Establishing Gateway Administrators” on page 61

“Enabling Message Status for Sent Items” on page 62

“Configuring Internet Connectivity” on page 63

Enabling Directory Synchronization and Exchange
Directory synchronization and exchange enable the Notes Gateway to automatically exchange 
Address Book information between the GroupWise system and the Notes system. 

Directory Exchange: Causes the gateway to perform a nightly exchange of the Notes public 
Address Book and GroupWise Address Book.

Directory Synchronization: Causes the gateway to update each Address Book as changes in 
Address Book information occur. If directory synchronization is not enabled, the Address 
Books are not updated until the nightly directory exchange occurs.

IMPORTANT: To ensure proper replication of names and addresses in both systems, use both directory 
synchronization and exchange.

1 Make sure the Notes system is set up to support directory synchronization and exchange, as 
described in Chapter 4, “Configuring the Notes Side of the Notes Gateway,” on page 25.

2 If you have domains in your GroupWise system that contain users that you do not want to 
appear in the Notes version of the GroupWise Address Book, use the /blockdoms switch in 
the startup files (notes.cfg) to list the GroupWise domains that should not be included in the 
directory synchronization and exchange process.

3 In ConsoleOne®, browse to and select the domain where you installed the Notes Gateway, 
right-click the Notes Gateway object, then click Properties to display the gateway 
Identification page.

4 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.
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5 In the Directory Sync/Exchange field, select Both.

6 Click Apply to save the setting.

7 Click Required Parameters to display the Required Parameters page. 

8 Make sure that the GroupWise Foreign Domain and Notes ID Password fields are filled in, as 
described in “Setting Required Parameters” on page 36.

When you provided this information during the initial configuration before installation of the 
Notes Gateway software, the foreign (non-GroupWise) domain was created automatically 
when you first started the Notes Gateway. Under the non-GroupWise domain, an external post 
office was created for each Notes domain and given the same name as the corresponding 
Notes domain. However, no user information was transferred at that time.
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Now that you have enabled directory exchange and synchronization, Notes users will be 
added to these external post offices as external GroupWise users.

9 Make sure that Outbound Conversion is set to None.

10 Click OK.

ConsoleOne passes the directory synchronization and exchange information to the Notes 
Gateway so that it can start transferring user information. The larger the Address Books are, 
the longer the process will take.

11 If you edited the notes.cfg file in Step 2, stop and then start the Notes Gateway so that it reads 
the updated startup file.

You can see the results of directory synchronization and exchange in the following locations:

Notes users appear in ConsoleOne because External Users objects are created in the External 
Post Office objects that represent Notes domains.

Notes users appear in the GroupWise Address Book because they have External User objects 
in the GroupWise system.

GroupWise users appear in a new Notes version of the GroupWise Address Book because the 
Notes Gateway creates the wpnames.nsf file in the \lotus\domino\data or \lotus\notes\data 
directory on the Notes/Domino server.

Notes Gateway Web Console
You can see whether directory synchronization and exchange are enabled on the Configuration 
page. You can turn directory synchronization and exchange on and off for the current gateway 
session on the Optional Gateway Settings page.

Configuring Addressing
When you take advantage of directory synchronization and exchange, as described in “Enabling 
Directory Synchronization and Exchange” on page 45, GroupWise users and Notes users can 
select each other out of their familiar Address Books. Addressing is not an issue under these 
circumstances.

If you do not want to enable directory synchronization and exchange, you must use other 
addressing alternatives:

“Adding Individual Notes Users to the GroupWise Address Book” on page 47

“Adding Individual Notes Users to Personal Address Books” on page 50

“Using Explicit Addressing” on page 50

Adding Individual Notes Users to the GroupWise Address Book
If there are some specific Notes users who you want to appear in the GroupWise Address Book, 
you can add those individual users without enabling directory synchronization and exchange. You 
add Notes users to the GroupWise Address Book by defining them as external users and then 
specifying the explicit addresses required to route messages to them in the Notes system.

1 In ConsoleOne, select GroupWise System, select the non-GroupWise domain that represents 
the Notes system, then select the external post office that represents the Notes domain where 
the Notes user is located.
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2 Right-click the GroupWise Post Office object that represents the Notes domain, then click 
New > External User.

3 Type a username, then click OK.

4 Right-click the new External User object, then click Properties.

5 Fill in fields as needed to provide information about the user that you want to appear in the 
GroupWise Address Book.

6 Click Apply to save the user information.

7 Click GroupWise > Gateway Aliases to display the Gateway Aliases page.
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You use the Gateway Aliases page to define the explicit address required to route messages 
to the user in the Notes system.

8 Click Add to display the Create Alias dialog box.

9 Fill in the following fields:

Gateway Alias Type: From the list, select the Notes Gateway.

The gateway alias type was defined during configuration of the gateway. If there is no 
gateway alias type listed for the gateway, you can define one now. See “Providing Gateway 
Information” on page 35.

Gateway Alias: Specify the user's address as defined in Notes.

 For example, if SJones@Provo is the user's address in Notes, then specify that address.

10 Click OK to save the gateway alias and return to the Gateway Alias page.

The gateway alias is now listed in the Gateway Alias list.

11 Click OK to save the list.

ConsoleOne passes the alias information to the Notes Gateway so that the Notes user is added 
to the GroupWise Address Book.

12 Repeat Step 2 through Step 11 for each Notes user you want to add to the GroupWise Address 
Book.
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Adding Individual Notes Users to Personal Address Books
GroupWise users can also add Notes users to their personal address books if the Notes users are 
not already defined in the GroupWise Address Book. 

1 In the GroupWise Windows client, click Tools > Address Book to open the Address Book.

2 Select a personal address book.

3 Click New > Contact > OK.

4 Fill in the following fields:

First: Specify the user's first name.

Last: Specify the user's last name.

E-mail Address: Specify the explicit address required to route a message to the Notes user. 
For syntax and examples, see “Explicit Addressing from GroupWise to Notes” on page 50.

5 Click OK to save the new contact in the personal address book.

Using Explicit Addressing
If you do not enable directory synchronization and exchange, and if Notes users are not 
represented in the GroupWise Address Book, then users on both sides of the gateway must use 
explicit addressing.

“Explicit Addressing from GroupWise to Notes” on page 50

“Explicit Addressing from Notes to GroupWise” on page 51

Explicit Addressing from GroupWise to Notes

To send a message to a Notes user using explicit addressing, GroupWise users must use the 
following syntax in the To line:

Syntax:
gateway_name:notes_domain.recipient's_short_name
gateway_name:"recipient's_short_name@notes_domain"
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where gateway_name is the name of the Notes Gateway established during installation as 
described in “Choosing a Gateway Name” on page 16. 

Examples:
Notes:Provo.SJones
Notes:"SJones@Provo"

Explicit Addressing from Notes to GroupWise

To send a message to a GroupWise user using explicit addressing, Notes users must use the 
following syntax in the To line:

Syntax:
domain.post_office.userID@foreign_domain

where foreign_domain is the name of the Notes foreign domain, as set up following the 
instructions in “Defining the GroupWise System As a Notes Foreign Domain” on page 26.

Example:
Corporate.Marketing.LTanaka@GroupWise

If the user ID is unique in the GroupWise system, then shorter syntax can be used:

Syntax:
userID@foreign_domain

Example:
LTanaka@GroupWise

Controlling Gateway Access
The Notes Gateway lets you control access through the gateway. For example, you can:

Specify which GroupWise users can send messages and to which Notes users

Specify which GroupWise users can receive messages and from which Notes users

Specify the maximum size for messages sent through the gateway

Specify whether or not rule-generated GroupWise messages are sent through the gateway

The standard way to control access for all GroupWise and Notes users on the GroupWise side of 
the gateway is with the access.cfg file in the domain\wpgate\notes directory. In addition, you can 
control individual user access using the Gateway Access field of individual User objects in 
ConsoleOne.

“Using the Access.cfg File in the Gateway Directory” on page 52

“Using the Gateway Access Field on Individual User Objects” on page 56

On the Notes side of the gateway, access control is provided on the Restrictions page of the Notes 
foreign domain that represents the GroupWise system, as described in “Defining the GroupWise 
System As a Notes Foreign Domain” on page 26.
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Using the Access.cfg File in the Gateway Directory
The access.cfg file is an ASCII text file that can be edited with a standard text editor. It is located 
in the gateway root directory (for example, domain\wpgate\notes). The access.cfg file enables you 
to implement the following specific types of access control:

Provide specific access control based on GroupWise domains and post offices

Provide specific access control based on access groups that you define

Limit the size of incoming and outgoing messages to and from your GroupWise system for 
specific domains, post offices, or access groups

Prevent messages from specific addresses from entering your GroupWise system for specific 
domains, post offices, or access groups

Allow messages from specified addresses to enter your GroupWise system, while preventing 
all others for specific domains, post offices, or access groups

Prevent rule-generated messages from going out of your GroupWise system for specific 
domains, post offices, or access groups

The initial access.cfg file includes descriptions and examples of the section headers and keywords 
that you can use in the file. However, all lines are initially commented out and access control is off 
by default. Print the initial access.cfg file in the domain\wpgate\notes directory. Reviewing the file 
will help you understand how it works.

Add the following line at the top of the file to turn on access control:

Access Control=On

After access control has been turned on, you can create sections in the access.cfg file for various 
groups of users. Within each section, you define the access control settings for the group to which 
the section applies. The following section headers and keywords are available:

Section headers, keywords, and settings are not case sensitive. The In and Out directions are from 
the point of view of the GroupWise system.

Notes Gateway Web Console
You can turn access control on and off for the current gateway session on the Access Control page. 
You can also adjust the maximum message size.

Section Headers

Section headers establish groups of users to which access control settings are applied.

“[Default:In|Out]” on page 53

“[groupwise_domain:In|Out]” on page 53

“[groupwise_domain.post_office:In|Out]” on page 53

“[AccessGroup:group_name]” on page 54

Section Headers Keywords

[Default:In|Out]
[groupwise_domain:In|Out]
[groupwise_domain.post_office:In|Out]
[AccessGroup:group_name]

AllAccess
NoAccess
Block
Allow
MaxSize
AllowRuleGenerated
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[Default:In|Out]

This section lists the access control settings for users who are not covered by access control 
settings for a particular GroupWise domain, post office, or access group.

Syntax:
[Default:In]
[Default:Out

Examples:
[Default:In]
MaxSize=100000
[Default:Out]
AllowRuleGenerated=No

This example limits incoming messages to 100 KB but does not limit the size of outgoing 
messages. It prevents rule-generated GroupWise messages from transferring through the gateway 
to the Notes system. These access control settings would apply to any users who did not fall under 
a more specific section header.

[groupwise_domain:In|Out]

This section lists the access control settings for users in a particular GroupWise domain.

Syntax:
[groupwise_domain:In]
[groupwise_domain:Out]

Examples:
[Corporate:In]
MaxSize=100000000
[Corporate:Out]
AllowRuleGenerated=Yes

This example limits incoming messages to 1 MB but does not limit outgoing messages. It allows 
GroupWise users to send rule-generated messages.

[groupwise_domain.post_office:In|Out]

This section lists the access control settings for users in a particular GroupWise post office.

Syntax:
[groupwise_domain.post_office:In]
[groupwise_domain.post_office:Out]

Examples:
[Corporate.Temps:In]
Allow NetTech
MaxSize=10000
[Corporate.Temps:Out]
Allow NetTech
MaxSize=10000
AllowRuleGenerated=No

This example allows users in the Temps post office to exchange messages with users in the Notes 
NetTech domain only. It restricts incoming and outgoing messages to 10 KB. It prevents rule-
generated messages.
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[AccessGroup:group_name]

This section lists the access control settings for individual GroupWise users who are assigned to 
the access group in ConsoleOne, as described in “Using the Gateway Access Field on Individual 
User Objects” on page 56. Access groups do not have direction parameters. If you want to control 
access in both directions, you must create separate access groups.

Syntax:
[AccessGroup:group_name]

Examples:
[AccessGroup:SysAdminsIn]
MaxSize=5000000
[AccessGroup:SysAdminsOut]
MaxSize=5000000
AllowRuleGenerated=Yes

This example allows users in the SysAdminsIn and SysAdminsOut access groups to receive 
messages up to 5 MB in size and to send rule-generated messages. 

Keywords

Keywords define the access control settings for the users included under each section header.

“AllAccess” on page 54

“NoAccess” on page 54

“Block” on page 55

“Allow” on page 55

“MaxSize” on page 56

“AllowRuleGenerated” on page 56

AllAccess

This keyword provides unrestricted access to the Notes Gateway for those GroupWise users 
specified by the section header. Users can send messages to or receive messages from Notes users, 
depending on the direction specified by the header.

Examples:
[Corporate.Executives:In]
AllAccess
[Corporate.Executives:Out]
AllAccess

This example allows all GroupWise users in the Executives post office to exchange messages with 
all Notes users with no access control restrictions.

NoAccess

This keyword restricts access to the Notes Gateway for those GroupWise users specified by the 
section header. Users cannot send or receive messages through the gateway, depending on the 
direction specified in the header.

Examples:
[Corporate.Temps:In]
NoAccess
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[Corporate.Temps:Out]
NoAccess

This example prevents all GroupWise users in the Temps post office from exchanging messages 
with Notes users.

Block

This keyword restricts access to the Notes Gateway from the perspective of Notes users. This 
keyword differs from NoAccess because a specific Notes address must be specified. If GroupWise 
users try to send mail to a Notes address that has been blocked, they will receive a message from 
the gateway stating that the message is undeliverable.

Syntax:
Block notes_domain
Block username@notes_domain
Block CN=full_name/O=organization@notes_domain

Examples:
[Corporate.Temps:In]
Block XYZCorp
[Corporate.Temps:Out]
Block XYZCorp

[Corporate.Executives:In]
Block SJones@XYZCorp
Block CN=Sophie Jones/O=Sales@XYZCorp

The first example prevents GroupWise users in the Temps post office from exchanging messages 
with users in the Notes XYZCorp domain. The second example prevents GroupWise users in the 
Executives post office from receiving messages from a specific Notes user. Providing the 
username in both formats is required to totally block a user.

Allow

This keyword allows messages to pass through the Notes Gateway only if the message's recipient 
matches the Notes address specified on the Allow line. Any messages addressed to other Notes 
addresses will be blocked.

Syntax:
Allow notes_domain
Allow username@notes_domain
Allow CN=full_name/O=organization@notes_domain

Examples:
[Corporate.Temps:In]
Allow NetTech
[Corporate.Temps:Out]
Allow NetTech

[Default:In]
Allow SJones@XYZCorp
Allow CN=Sophie Jones/O=Sales@XYZCorp

The first example allows GroupWise users in the Temps post office to exchange messages with 
the NetTech Notes domain but no others. The second example allows all users to receive messages 
from a specified user. 
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MaxSize

This keyword determines the maximum size of messages that the Notes Gateway will transfer 
between systems. Maxsize is specified in bytes (1000 = 1000 bytes or 1 KB), with a range from 0 
to 2147483647.

Unless you have a reason to limit the message size (for example, you are charged for the amount 
of data transferred by the gateway), you might not want to limit the message size. When 
attachments are encoded as they pass through the gateway, they generally become larger.

Syntax:
Maxsize=number _of_bytes

Example:
[Corporate.Temps:In]
MaxSize=1000000
[Corporate.Temps:Out]
MaxSize=5000000

This example prevents GroupWise users in the Temps post office from receiving messages larger 
than 1 MB and from sending messages larger than 5 MB.

AllowRuleGenerated

This keyword determines whether or not rule-generated messages are allowed through the Notes 
Gateway. It applies only to outbound messages from GroupWise to Notes.

You could use this keyword to control rule-generated messages such as "On Vacation" from 
entering the Notes system. Unlike NoAccess and Block, the gateway does not generate a status 
message stating that the mail message was undeliverable. Instead, the message remains pending in 
the sender's mailbox.

Syntax:
AllowRuleGenerated=Yes | No

Example:
[Default:Out]
AllowRuleGenerated=No

This example prevents all rule-generated messages from transferring from the GroupWise system 
to the Notes system.

Using the Gateway Access Field on Individual User Objects
You can use the Gateway Access field on the GroupWise Account page of each User object in 
ConsoleOne to control individual user access. This can be useful if you only have a few users 
whose access you want to control. If you have many users whose access you want to control, you 
should use the access.cfg file, as described in “Using the Access.cfg File in the Gateway 
Directory” on page 52.

1 If desired, create an access control group in the access.cfg file.

2 In ConsoleOne, browse to and right-click the user whose access you want to control, then 
click Properties.

3 Click GroupWise > Account to display the Account page.
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4 Fill in the Gateway Access field. 

If you created an access control group in the access.cfg file in Step 1, specify the name of the 
access control group that you want this user to be associated with.

If you have not created an access control group, you can put access control information unique 
to this user in the Gateway Access field.

Syntax:
gateway.direction:keyword,keyword,...,keyword;gateway.direction:keyword,...,keyword

The following keywords are valid in the Gateway Access field:

AllAccess

NoAccess

MaxSize

AllowRuleGenerated
IMPORTANT: The Block and Allow keywords cannot be used in the Gateway Access field. They can 
only be used in the access.cfg file.

Example:
Notes.Out:MaxSize=500000,AllowRuleGenerated=No;Notes.In:Maxsize=500000

In this example, the gateway name is Notes, the maximum message size is 500 KB, and rule-
generated messages are prevented from leaving the GroupWise system. The gateway 
direction designations and their keywords are separated by a semicolon (;).

5 Click OK to save the access control information for the selected user.

ConsoleOne passes the access control information to the Notes Gateway so that the access 
control settings are in force immediately.
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Setting Up Accounting
Every day at midnight, the Notes Gateway creates an accounting file (acct) in the 
domain\wpgate\notes\000.prc directory. The acct file is an ASCII-delimited text file that records 
the source, priority, message type, destination, and size of each item passing through the gateway. 

“Enabling Accounting” on page 58

“Defining an Accountant” on page 59

“Understanding the Accounting File” on page 60

Enabling Accounting
1 In ConsoleOne, browse to and right-click the Notes Gateway object, then click Properties.

2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.

3 Make sure Accounting is set to Yes.

4 Click Apply to save your changes.

5 Continue with “Defining an Accountant” on page 59.

Notes Gateway Web Console
You can turn accounting on and off for the current gateway session on the Optional Gateway 
Settings page.
58   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
Defining an Accountant
1 On the Notes Gateway object, click GroupWise > Gateway Administrators to display the 

Gateway Administrators page.

The Gateway Administrators page lets you select a GroupWise user to be the Accountant for 
the Notes Gateway. Each night at midnight, the gateway mails the accounting file (acct) to the 
Accountant.

2 Click Add to open the Select GroupWise Object dialog box, then select a user to function as 
the Accountant for the Notes Gateway.

You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

3 Click OK to return to the Gateway Administrators page.

4 In the Administrators list, select the user or distribution list that you want to function as the 
Accountant.

In the Administrators list, you can also select multiple users and distribution lists as needed.

5 In the Administrator Role box, select Accountant.

6 Click OK to save the changes.

ConsoleOne passes the accounting information to the Notes Gateway so that the Accountant 
will begin receiving daily accounting files.

7 Continue with “Understanding the Accounting File” on page 60.
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Understanding the Accounting File
The accounting file (acct) is an ASCII-delimited text file that records the source, priority, message 
type, destination, and other information about each message sent through the gateway. The file, 
which is updated daily at midnight is located in the domain\wpgate\notes\000.prc directory. If no 
Accountant is defined to receive the file, the file is deleted each day.

A sample line from an accounting file is shown below:

O,05/18/03, 20:42:55,,
Mail,3,Corporate,Temps,LTanaka,,Reminder,Connector,Notes,,
Mail,SJones@Provo,1,0,2593

Each item sent through the gateway is recorded on a separate line, with the fields separated by 
commas. Two or more commas in a row indicate that a field has no data. The following table 
describes the fields in the order in which they are found in the accounting file.

Field Description Example

In/Out Status Indicates if the message is outbound (O) or inbound (I) O

Message Date The date when the message was sent 5/18/03

Message Time The time when the message was sent 20:42:55

GroupWIse Message ID A set of numbers that uniquely identifies the message 
in the GroupWise system

3F429BA6.961 : 
12 : 31746

GroupWise Message 
Type

Type of item sent or received Mail

GroupWise Message 
Priority

0 = High
2 = Normal
4 = Low

2

GroupWise User Domain The GroupWise domain where the sender’s or 
receiver’s post office is located

Corporate

GroupWise User Post 
Office

The GroupWise post office that the sender or recipient 
belongs to

Temps

GroupWise User ID The user ID of the sender or recipient LTanaka

GroupWise Account ID The recipient’s or sender's account ID as specified on 
the user's GroupWise Account page in ConsoleOne

Message Subject The subject line of the message Reminder

Gateway Domain The GroupWise domain where the gateway is installed Connector

Gateway Name The name of the gateway as defined in GroupWise Notes

Foreign Message ID The message ID supplied by Notes

Foreign Message Type The type of message sent from Notes Mail

Foreign Address The user's Notes address or GroupWise address (if the 
user was added to a non-GroupWise domain)

SJones@Provo

Number of Recipients The number of users 1
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The acct file can be imported into a word processor, spreadsheet, or database program for further 
analysis.

Establishing Gateway Administrators
A gateway administrator is any GroupWise user you assign to receive information and error 
messages from the Notes Gateway. The gateway does not require an administrator, but if you want 
to define one, the administrator must either be a user who is associated with GroupWise or with a 
GroupWise distribution list. There are several types of administrators that you can define for the 
Notes Gateway:

1 In ConsoleOne, browse to and select the Notes Gateway object, then click Properties.

2 Click GroupWise > Gateway Administrators to display the Gateway Administrators page.

Number of Attachments The number of files attached to the message 0

Accounting Units The byte size of the message 2593

Administrator Type Description

Operator The Operator receives a message if the Notes Gateway cannot communicate 
with the GroupWise system.

Foreign Operator The Foreign Operator receives a message if the Notes Gateway cannot 
communicate with the Notes system.

Postmaster The Postmaster receives bad message files if the /badmsg switch is in use. 
See “Notifying the Notes Gateway Administrator about Bad Messages” on 
page 78.

Accountant The gateway keeps accounting records for every message it sends, unless you 
turn the Accounting feature off. Accounting data for the previous day's activity 
is sent daily to the Accountant. For setup information, see “Setting Up 
Accounting” on page 58.

Field Description Example
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3 Click Add to display the Select Object dialog box, then select the user you want to define as 
an administrator.

You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

4 Click OK to return to the Gateway Administrators page and add the user to the Gateway 
Administrators list. 

5 In the Administrator Role box, select the type of administrator you want the user to be.

Operator

Accountant

Postmaster 

Foreign Operator

6 Click OK to save the Notes Gateway administrator list.

ConsoleOne passes the administrator information to the Notes Gateway so that the 
administrators start receiving the appropriate types of messages.

Enabling Message Status for Sent Items
Both GroupWise and Notes can return status information to message senders. This lets senders 
know if their messages have been delivered, opened, and so on. In order for message status 
information to be returned to senders, you need to make sure that message status has been enabled. 
Message status information is collected in the status correlation database (gwcorr.db), located by 
default in the domain\wpgate\notes directory. 

1 If you want to change the location of the status correlation database, use the /corr startup 
switch in the Notes Gateway startup file (notes.cfg) to specify a different directory.

2 In ConsoleOne, browse to and right-click the Notes Gateway object, then click Properties.

3 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.
62   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
4 Fill in the following fields:

Outbound Status Level: Outbound status refers to the status information returned to 
GroupWise users for messages they send to Lotus Notes users. Select Undelivered, Delivered, 
Open, or Full (which is equivalent to choosing Undelivered, Delivered, and Open). 

Correlation Enabled: Select Yes. Message correlation is used to map Notes delivery, non-
delivery, and receipt reports to GroupWise status messages, and GroupWise status messages 
to Notes delivery, non-delivery, and receipt reports. For tracking purposes, each message 
receives its own record in the correlation database (domain\wpgate\notes\gwcorr.db).

Correlation Age: Specify the number of days you want a message's record to remain in the 
correlation database. After a message's record has been deleted, any status information 
returned on the message is sent to the user as a new message rather than as status information 
on the old message.

5 Click OK to save the changes.

ConsoleOne passes the status message information to the Notes Gateway so that status 
messages and correlation start immediately.

6 If you edited the notes.cfg file in Step 1, stop and then start the Notes Gateway so that it reads 
the updated startup file.

Notes Gateway Web Console
You can adjust these settings for the current gateway session on the Optional Gateway Settings 
page.

Configuring Internet Connectivity
By default, the Notes Gateway uses the Notes Internet connector for sending messages from Notes 
users to Internet users. As an alternative, you can configure the gateway to use an Internet Agent 
in your GroupWise system for Internet connectivity. Use the /ic switch in the Notes Gateway 
startup file (notes.cfg) to specify the Internet Agent (domain_name.agent_name).
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8 Monitoring the Notes Gateway

By monitoring the Notes Gateway, you can determine whether or not its current configuration is 
meeting the needs of the users it services. You have a variety of tools to help you monitor the 
operation of the Notes Gateway:

“Using the Notes Gateway Console” on page 65

“Using the Notes Gateway Web Console” on page 68

“Using Notes Gateway Log Files” on page 74

“Using SNMP Monitoring Programs” on page 75

“Notifying the Notes Gateway Administrator about Bad Messages” on page 78

“Understanding Notes Gateway Error Messages” on page 78

Using the Notes Gateway Console
The Notes Gateway console displays the gateway's activity when it is running as an application. If 
you run the Notes Gateway as a Windows service, the console does not appear and you must use 
other monitoring alternatives, as described in “Using the Notes Gateway Web Console” on page 68 
and “Using SNMP Monitoring Programs” on page 75.

To properly administer the gateway as an application, you should understand the console and how 
it works. The screen is divided into various areas.

“Information Box” on page 66

“Status Box” on page 66

“Statistics Box” on page 66
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“Log Message Box” on page 67

“Menu Summary” on page 67

Information Box
The top portion of the console provides the following information about the gateway. 

Domain.Gateway: The domain where the gateway is installed and the name of the gateway.

UpTime: The length of time the gateway has been running.

Description: The description you added when you configured the gateway, as described in 
“Providing Gateway Information” on page 35.

Status Box
The Status box provides the following information:

Processing: If the gateway is running, this field displays a spinning bar. If there is no bar or if the 
bar is stationary for an extended period, the gateway is not running.

GroupWise: Whether the gateway's network connection to the GroupWise® domain is Open or 
Closed. It is normal for this field to briefly display Closed while the gateway is initializing. If the 
link shows Closed for an extended period, a network failure, insufficient access rights, or an error 
in setup fields could be the problem. Check for error messages in the Log Message box. For 
assistance resolving error messages, see Appendix A, “Notes Gateway Error Messages,” on 
page 91.

Other Link: The status of the gateway's network connection to the Notes system. Messages can 
be sent or received if Other Link is Open. If it is Closed, the network connection has been 
terminated. Check the status of the Notes system.

Program: Where the gateway is in its current processing cycle (sending, receiving, or idle). You 
can use the Gateway Time Settings page in ConsoleOne® to adjust the processing cycle. For more 
information, see “Adjusting the Gateway’s Send/Receive Cycle” on page 79.

Log Level: The logging level the gateway is currently using. The level determines how much 
information is displayed in the Logging box and written to the log file. You can set the default 
logging level in ConsoleOne, as described in “Using Notes Gateway Log Files” on page 74. You 
can also change the log level for the current Notes Gateway session, as described in “Menu 
Summary” on page 67.

Statistics Box
The Statistics box displays the amount of incoming and outgoing gateway traffic. The four 
columns display the cumulative totals and the snap shot totals. The four columns from left to right 
are: outgoing message totals, snap shot of outgoing messages (the default snap shot interval is 10 
minutes), incoming message totals, and snap shot of incoming messages.

The snap shot interval statistic can help you get a more accurate picture of the amount of recent 
gateway traffic. For information about changing the snap shot interval, see “Adjusting the 
Gateway’s Send/Receive Cycle” on page 79

The following types of status information are provided:

Normal: The number of normal incoming and outgoing messages the gateway has processed.
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Status: The number of status messages the gateway has sent and received. The amount of status 
message traffic depends in part on the outbound status level of the gateway. An outbound status 
level set to Full causes more status messages than an outbound status level set to Undelivered. For 
more information about setting the outbound status level, see “Enabling Message Status for Sent 
Items” on page 62.

Passthru: The number of incoming and outgoing passthrough messages the gateway has 
processed. Using the Notes Gateway as a passthrough gateway between two GroupWise systems 
is not a recommended way to connect GroupWise systems. There are better alternatives currently 
available. See the GroupWise 6.5 Multi-System Administration Guide for preferred alternatives.

Conv Errors: The number of conversion errors for incoming and outgoing messages.

Comm Errors: The number of communications errors for incoming and outgoing messages.

Total Bytes: The total number of bytes for the incoming and outgoing messages.

Log Message Box
The Log Message box displays the Notes Gateway’s activity. The amount and detail in this display 
depends on the logging level you select. For more information, see “Using Notes Gateway Log 
Files” on page 74.

For assistance with error messages that appear in the Log Message box, see Appendix A, “Notes 
Gateway Error Messages,” on page 91.

Menu Summary
At the top of the Notes Gateway console is a menu bar that provides the following functionality:

Menu Item Function Key Function

File Exit F7 Stop the Notes Gateway.

Configuration Gateway 
Settings

F5 Display the gateway configuration settings from the 
Notes Gateway object in Novell® eDirectoryTM. For 
more information, see Chapter 5, “Configuring the 
GroupWise Side of the Notes Gateway,” on page 35 
and various sections in Chapter 6, “Running the Notes 
Gateway,” on page 39.

Log View Log Files F9 Select a log file and view it in Notepad. See “Using 
Notes Gateway Log Files” on page 74.

Log Settings F2 Override the default log settings for the current Notes 
Gateway session. See “Using Notes Gateway Log 
Files” on page 74.

Actions Zero Status F8 Reset all statistics to zero.

Synchronize 
Directories

N/A Synchronize the GroupWise and Notes Address Books 
immediately. See “Enabling Directory Synchronization 
and Exchange” on page 45.
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Using the Notes Gateway Web Console
The Notes Gateway Web console enables you to monitor and control the Notes Gateway from any 
location where you have access to a Web browser and the Internet. This provides substantially 
more flexible access than the Notes Gateway console, which can be accessed only from the 
Windows machine where the Notes Gateway is running.

“Setting Up the Notes Gateway Web Console” on page 68

“Accessing the Notes Gateway Web Console” on page 70

“Monitoring the Notes Gateway from the Web Console” on page 70

Setting Up the Notes Gateway Web Console
During installation, the Installation program offered you the opportunity to set up the Notes 
Gateway Web console.

The information that you provided during installation was recorded in the Notes Gateway startup 
file (notes.cfg). If you want to change the information provided during installation, you must edit 
the startup file. As an alternative, you can remove the Web console information from the startup 
file and configure the Web console in ConsoleOne as described below.

If you did not enable the Web console during installation, you can do it now in ConsoleOne.

1 In ConsoleOne, browse to and right-click the Notes Gateway object, then click Properties.

2 Click GroupWise > Network Address to display the Network Address page.
68   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
3 In the HTTP Port field, provide a unique port number for communication between the Notes 
Gateway and your Web browser. 

 You might want to use a port number close to those used by the MTA and POA, for example, 
7175.

4 Make a note of the HTTP port number. You will need this information to access the Notes 
Gateway Web console.

5 Click Apply to save your changes on the Network Address page.

If you want to limit access to the Notes Gateway Web console, you can provide a username 
and password.

6 Click GroupWise > Optional Gateway Settings.

7 In the HTTP Settings box:

7a In the HTTP User Name field, specify a unique username.
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7b Click Set Password.

7c Type the password twice for verification.

7d Click Set Password.

Do not use an eDirectory username and password because the information passes over the 
insecure connection between your Web browser and the Notes Gateway.

For convenience, use the same username and password for all agents and gateways that you 
plan to monitor from GroupWise Monitor. This saves you from having to provide the 
username and password information as Monitor accesses each agent and gateway.

8 Click OK to save the Notes Gateway Web console settings.

ConsoleOne then notifies the Notes Gateway to restart so the new settings can be put into 
effect.

Corresponding Startup Switches:
You could also use the /httpport, /httpuser, and /httppassword startup switches in the Notes 
Gateway startup file (notes.cfg) to enable and secure the Notes Gateway Web console. In addition, 
you can use the /httprefresh switch to control how often the Notes Gateway refreshes the 
information provided to your Web browser.

Accessing the Notes Gateway Web Console
To monitor the Notes Gateway from your Web browser, view the URL where the Notes Gateway 
is located by supplying the network address of the Windows machine where the Gateway runs and 
port number as provided on the Network Address page in ConsoleOne.

Syntax:
http://IP_address_or_hostname:HTTP_port

Examples:
http://172.16.5.18:7175

http://notesserver1:7176

Monitoring the Notes Gateway from the Web Console
The Notes Gateway Web console provides several pages of information to help you monitor the 
performance of the Notes Gateway. The bar at the top of the Notes Gateway Web console displays 
the name of the Notes Gateway and its post office. Below this bar appears the Notes Gateway Web 
console menu that lists the pages of information available in the Notes Gateway Web console. 
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Monitoring Gateway Status

When you first access the Gateway Web console, the Status page is displayed.

The information is the same as is displayed on the Gateway console on the Windows machine 
where the gateway runs. For more information, see “Status Box” on page 66.

Checking Gateway Configuration

On the Notes Gateway Web console menu, click Configuration to display the configuration 
information stored on various property pages on the Notes Gateway object in ConsoleOne.

To change the log settings for the current gateway session, click Event Log Settings. All other 
settings listed on the Configuration page must be changed in ConsoleOne.

Checking the Operating System Environment

On the Notes Gateway Web console menu, click Environment to display information about the 
operating system where the Notes Gateway is running. 
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Viewing Gateway Log Files

On the Notes Gateway Web console menu, click Log Files to display gateway log files.

Click Event Log Settings to change the log settings for the current Notes Gateway session. 

For information about Notes Gateway log files, see “Using Notes Gateway Log Files” on page 74.

Checking and Changing Gateway Time Settings

On the Notes Gateway Web console menu, click Time Settings to display the settings listed on the 
Time Settings page in ConsoleOne.
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Modify the settings as needed, then click Submit to change them for the current Notes Gateway 
session. For information about the time settings, see “Adjusting the Gateway’s Send/Receive 
Cycle” on page 79.

Checking and Changing Optional Gateway Settings

On the Notes Gateway Web console menu, click Optional Gateway Settings to display the settings 
listed on the Optional Gateway Settings page in ConsoleOne.

Modify the settings as needed, then click Submit to change them for the current Notes Gateway 
session. For information about the optional gateway settings, see the following topics:

“Enabling Directory Synchronization and Exchange” on page 45

“Setting Up Accounting” on page 58

“Enabling Message Status for Sent Items” on page 62

“Using Notes Gateway Startup Switches” on page 83

Changing Gateway Access Control

On the Notes Gateway Web console menu, click Access Control to turn access control on and off 
and to adjust the maximum message size for the current Notes Gateway session.

For information about access control, see “Controlling Gateway Access” on page 51.
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Using Notes Gateway Log Files
Log files record all message routing data that appears in the Log Message box of the Notes 
Gateway console. You can determine the level of information you want to log, as well as the 
maximum age for log files and the maximum amount of disk space to be used for log files. 
Examining log files is useful if you experience any problems with the Notes Gateway, because the 
log files record the exact route all messages take. If you have any problems that require assistance 
from Novell Support, it is likely that the technician who helps you will request a copy of this file. 

Log files are stored in the gateway's 000.prc directory (domain\wpgate\notes\000.prc) and can be 
viewed from the gateway console and the Web console. Log files are named mmddlog.nnn, where 
mmdd is the month and day and nnn is an incrementing number, starting with 001.

1 In ConsoleOne, browse to and right-click the Notes Gateway object, then click Properties.

2 Click GroupWise > Log Settings to display the Log Settings page.

3 Fill in the following fields:

Log File Path: Select the path where the log file should be created. By default, log files are 
stored in the domain\wpgate\notes\000.prc directory.

Logging Level: Select the logging level you want. Gateway logging levels are hierarchical, 
with Off as the lowest and Diagnostic as the highest.

Off: Disables logging.

Normal: Displays basic message routing information, providing a summary of gateway 
activity. This is the default setting.

Verbose: Displays extra message routing details and message processing information.

Diagnostic: Displays all message routing and processing information. You should use 
this logging level only when troubleshooting a problem with the gateway.
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A new log file is created each day, and the files accumulate according to the following 
settings:

Max Log File Age: Specify the maximum number of days you want to save the log file before 
the gateway deletes it. The default value is 7 days.

Max Log Disk Space: Specify the amount of disk space you want the limit to be for log files. 
When the limit is reached, the gateway deletes the oldest file until the space occupied is under 
the maximum allowable limit. The default value is 1024 KB.

If you set the limit to zero (0), there will be no disk space limit for log files.

4 Click OK to save the log settings.

ConsoleOne passes the updated log settings to the Notes Gateway so that the new log settings 
are in force immediately.

Corresponding Startup Switches
You could also use the /log, /loglevel, /logdays, and /logmax startup switches in the Notes Gateway 
startup file (notes.cfg) to control logging.

Notes Gateway Web Console
You can view the Notes Gateway log files and change the log settings for the current Notes 
Gateway session by clicking the Log Settings link on the Log Files page. You can also view and 
modify log settings at the Notes Gateway console on the machine where the gateway is running, 
as listed in “Menu Summary” on page 67.

Using SNMP Monitoring Programs
You can monitor the Notes Gateway from the Management and Monitoring component of Novell 
ZENworks® for Servers, ManageWise®, or any other SNMP management and monitoring 
program. When properly configured, the Notes Gateway sends SNMP traps to network 
management consoles for display along with other SNMP monitored programs.

During installation, you had the opportunity to configure the Notes Gateway for SNMP.

If you did not select SNMP support during installation, there is currently no way to add the 
functionality short of uninstalling the Notes Gateway and reinstalling it. See “Uninstalling the 
Notes Gateway” on page 42
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To set up SNMP services for the Windows machine, complete the following tasks:

“Copying and Compiling the Notes Gateway MIB File” on page 76

“Configuring the Notes Gateway for SNMP Monitoring” on page 76

Copying and Compiling the Notes Gateway MIB File
An SNMP-enabled Notes Gateway returns information contained in a Management Information 
Base (MIB). The MIB is an ASCII data structure that defines the information gathered. It also 
defines the properties that can be monitored and managed on the SNMP-enabled Notes Gateway. 
You can view the contents of the Notes Gateway MIB for a description of the SNMP variables 
available for it. The Notes Gateway MIB is located in the domain\wpgate\notes directory.

Before you can monitor an SNMP-enabled Notes Gateway, you must compile the ngwln.mib file 
using your SNMP management program. 

1 Copy the ngwln.mib file from the domain\wpgate\notes directory to the location required by 
your SNMP management program.

For example, ManageWise users would copy the ngwln.mib file to the 
\mw\nms\snmpmibs\current directory. The Notes Gateway MIB file includes annotations that 
enhance the Alert functions of ManageWise. For example, the Summary provides more 
detailed information than the Description does in other SNMP management programs. The 
ManageWise annotations are embedded in comments; therefore, they have no affect on other 
SNMP management programs.

ZENworks for Servers users could copy the ngwln.mib file to the \agents\snmp directory in 
the GroupWise software distribution directory.

2 Compile or import the ngwln.mib file as required by your SNMP management program.

For example, to compile the ngwln.mib file for ZENworks for Servers:

2a In ConsoleOne, right-click the Site Server object, then click Properties > MIB Pool.

2b Click Modify Pool > Add.

2c Browse to and select the ngwln.mib file, then click OK.

2d Click Compile.

2e To make sure that the Windows machine where the Notes Gateway is running is 
configured to send SNMP traps to the ZENworks for Servers Site Server, add the IP 
address or host name of the Site Server to the list of trap destinations.

From the Windows NT Control Panel, double-click Network, then click Services > 
SNMP Service > Properties > Traps.

From the Windows 2000 Control Panel, double-click Administrative Tools, then 
click Services > SNMP Service > Properties > Traps.

Refer to your SNMP management program documentation for specific instructions.

3 Continue with “Configuring the Notes Gateway for SNMP Monitoring” on page 76.

Configuring the Notes Gateway for SNMP Monitoring
In order for SNMP monitoring programs to monitor the Notes Gateway, the Notes Gateway must 
be configured with a network address and SNMP community string.

1 Browse to and right-click the Notes Gateway object, then click Properties.
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2 Click GroupWise > Network Address to display the Network Address page.

3 Click the pencil icon to provide the TCP/IP address or hostname of the machine where the 
Notes Gateway runs, then click Apply.

4 Click GroupWise > Identification.

5 Provide your system SNMP community GET string, then click OK.

ConsoleOne then notifies the Notes Gateway to restart so the new settings can be put into 
effect.

The Notes Gateway should now be visible to your SNMP monitoring program.
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Notifying the Notes Gateway Administrator about Bad Messages
Occasionally, the Notes Gateway encounters a message that it cannot process, either because the 
message file has been damaged or because the recipient is not a user that is recognized by the 
gateway. You can use the /badmsg switch in the Notes Gateway startup file to indicate how you 
want the Notes Gateway to handle messages that are damaged or undeliverable. 

By default, bad messages are moved to the domain\wpgate\notes\gwprob directory. If you do not 
want to do anything with bad messages, you can have the gateway delete them immediately, or 
you can have the gateway periodically clean up the gwprob directory, as described in “Setting Up 
Daily Maintenance Tasks” on page 82.

If you want to take a look at bad message files, you can have the gateway send the bad message 
files to the postmaster. If you do not yet have a postmaster, see “Establishing Gateway 
Administrators” on page 61 for setup instructions.

Understanding Notes Gateway Error Messages
As you monitor the Notes Gateway, you might occasionally see error messages. Notes Gateway 
error messages are documented with the source of the error, possible causes of the error, and 
actions to take to resolve the error. See Appendix A, “Notes Gateway Error Messages,” on 
page 91.
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9 Optimizing the Notes Gateway

You can adjust how the Notes Gateway functions in order to optimize its performance. Before 
attempting optimization, you should run the Notes Gateway long enough to observe its efficiency 
and its impact on other network applications running on the same machine. See Chapter 8, 
“Monitoring the Notes Gateway,” on page 65.

Also, remember that optimizing your network hardware and operating system can make a 
difference in Notes Gateway performance.

The following topics help you optimize the Notes Gateway:

“Adjusting the Gateway’s Send/Receive Cycle” on page 79

“Adjusting the Number of Sender and Receiver Threads” on page 80

“Automating Network Reattachment” on page 81

“Reducing Network Traffic” on page 82

“Setting Up Daily Maintenance Tasks” on page 82

Adjusting the Gateway’s Send/Receive Cycle
The Notes Gateway's send/receive cycle determines how much time the gateway spends sending 
messages as opposed to receiving them. The send process refers to messages sent from 
GroupWise® to Notes; the receive process refers to messages sent from Notes to GroupWise.

The default send/receive cycle is 120 seconds, which causes the gateway to send messages for a 
maximum of 60 seconds and then receive messages for 60 seconds. You can adjust the send/
receive cycle to better suit your environment and needs. You can also adjust some additional time-
related settings for the gateway.

1 In ConsoleOne®, browse to and right-click the Notes Gateway object, then click Properties.

2 Click GroupWise > Gateway Time Settings to display the Gateway Time Settings page.
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3 Fill in the following fields:

Send/Receive Cycle: Specify the maximum amount of time you want the gateway to spend 
sending and receiving messages during one cycle. The default (120 seconds) causes the 
gateway to send messages for a maximum of 60 seconds and to receive messages for 60 
seconds. The cycle is then repeated.

If the time limit is reached and a message is being processed, the gateway will finish 
processing the message.

Minimum Run: This field does not apply to the Notes Gateway.

Idle Sleep Duration: Specify the number of seconds the gateway is to remain idle if it has no 
commands or messages to process. The default value is 30 seconds.

The gateway constantly polls its directory for messages to process. The purpose of idle time 
is to save CPU cycles and to keep network traffic manageable.

Snap Shot Interval: The Notes Gateway console shows the gateway statistics for the last x 
minutes (an interval you specify). The default interval is 10 seconds. Gateway activity is 
updated every minute.

4 Click OK to save the updated time settings.

ConsoleOne then notifies the Notes Gateway to restart so the new settings can be put into 
effect.

Notes Gateway Web Console
You can adjust these settings for the current gateway session on the Time Settings page.

Adjusting the Number of Sender and Receiver Threads
The Notes Gateway can be configured to start from varying numbers of sender and receiver 
threads, depending on the amount of traffic passing through the gateway. The heavier the traffic, 
the more threads you should configure the gateway to start. By default, 4 sender threads and 4 
receiver threads are started.

Use the /st switch in the Notes Gateway startup file (notes.cfg) to set the number of sender threads. 
Use the /rt switch to set the number of receiver threads.
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Notes Gateway Web Console
You can check the number of sender and receiver threads that are currently available and in use on 
the Status page.

Automating Network Reattachment
When the Notes Gateway loses its link to the server where the GroupWise domain directory 
resides or its link to the Notes/Domino server, it can attempt to reestablish the link.

1 In ConsoleOne, browse to and right-click the Notes Gateway object, then click Properties.

2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings 
page.

3 Make sure that Enable Recovery is set to Yes.

4 Fill in the following fields:

Retry Count: Specify the number of times you want the gateway to attempt to recover the 
network link. The default is 10 times.

Retry Interval: Specify the amount of time you want the gateway to wait between retry 
attempts. The default value is 60 seconds.

Failed Recovery Wait: If the gateway cannot reconnect to the network after the number of 
times specified in Retry Count, it will stop attempting to reconnect. Specify the amount of 
time you want the gateway to wait until it starts the reconnect process again. The default value 
is 3600 seconds (1 hour).

Network Reattach Command: You can create a batch file that the gateway can use to 
reconnect to the network server where the GroupWise domain directory resides and to the 
Notes/Domino server. Specify the name of the batch file in this field.

5 Click OK to save the reattachment information.

ConsoleOne then notifies the Notes Gateway to restart so the new settings can be put into 
effect.
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Reducing Network Traffic
By default, the Notes Gateway's queue directories are located in the domain\wpgate\notes 
directory on the server where the domain is located. To reduce network traffic, you can redirect 
the gateway's queue directories to the Windows machine where the gateway is running.

If you choose to place the queue directories on the gateway machine's local drive, make sure the 
gateway machine has sufficient disk space, memory, and processing power to handle the load.

Start the gateway using the following startup switch:

ngate /work-queue_directory 

where queue_directory is the path to the directory where you want the gateway queues created. 
For example, you could use a c:\lngate directory on the local drive. Make sure the directory is not 
used by any other program. The gateway must have exclusive access to the directory; any 
unrecognized files in the directory are immediately moved to the gwprob subdirectory.

The first time you start the gateway using the /work switch, the gateway creates the necessary file 
structure in the specified directory. It creates a wpgate directory, with wpcsin and wpcsout queue 
directories. This local structure is used as long as you continue to start the gateway with the /work 
switch. You might want to add the /work switch to the startup file (notes.cfg) so the gateway 
always uses the same queue directory. See Chapter 10, “Using Notes Gateway Startup Switches,” 
on page 83. 

Setting Up Daily Maintenance Tasks
The Notes Gateway has the capability of running any maintenance commands you invoke. To take 
advantage of this capability, you must create a batch file called gwmaint.bat and include your 
Windows maintenance commands in it. Each day at midnight, the gateway will execute the 
commands in the gwmaint.bat file.

1 Use a text editor to open the gwmaint.bat file in the domain\wpgate\notes directory.

2 Specify the maintenance commands you want. You can include as many commands as 
necessary.

For example, the file could include the following line to delete any message files that are 
undeliverable or damaged.

del j:\connector\wpgate\notes\gwprob\*.bad (queue in the domain directory)

or

del c:\lngate\wpgate\notes\gwprob\*.bad (queue on the local machine)

3 Save the file in the domain\wpgate\notes directory.
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10 Using Notes Gateway Startup Switches

Startup switches let you set various operational parameters for the gateway. Some startup switches 
override configuration information, such as logging level, that you can set in ConsoleOne®. Other 
switches provide configuration options not available anywhere else.

To use a startup switch, you can include it on the command line immediately following the ngate 
executable command.

Example:
ngate /badmsg-send

You can also edit the Notes Gateway startup file (notes.cfg) to include the switches you want to 
use when starting the gateway. The notes.cfg file is located in the domain\wpgate\notes directory. 
Use the following syntax to include the startup file:

Example:
ngate @notes.cfg

The table below summarizes Notes Gateway startup switches and how they correspond to 
configuration settings in ConsoleOne.

Startup Switch ConsoleOne Setting

/badmsg N/A

/blockdoms N/A

/corr N/A

/group N/A

/help N/A

/home N/A

/httppassword HTTP Password

/httpport HTTP Port

/httprefresh N/A

/httpuser HTTP Username

/ic N/A

/lnsmb N/A

/log Log File Path

/logdays Maximum Log File Age
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/badmsg
Indicates what the gateway should do with bad message files (undeliverable or damaged). See 
“Notifying the Notes Gateway Administrator about Bad Messages” on page 78. The following 
options can be used:

Move: Instructs the gateway to move the bad message files to the 
domain\wpgate\notes\gwprob directory. This is the default action.

Send: Instructs the gateway to send the bad message files to the user assigned as the gateway's 
Postmaster. See “Establishing Gateway Administrators” on page 61. 

Both: Instructs the gateway to both move and send the bad message files.

Neither: Instructs the gateway to delete the files

Syntax:
/badmsg-option

Example:
/badmsg-both

/blockdoms
Prevents users in the specified GroupWise domains from appearing in the Notes version of the 
GroupWise Address Book when directory synchronization and exchange are enabled. See 
“Enabling Directory Synchronization and Exchange” on page 45.

Syntax:
/blockdoms-domain
/blockdoms-"list_of_domains"

Examples:
/blockdoms-domain1
/blockdoms-"domain1, domain2, domain3"

/loglevel Log Level

/logmax Maximum Log File Size

/noalias N/A

/rt N/A

/single N/A

/st N/A

/work N/A

Startup Switch ConsoleOne Setting
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/corr
Specifies the path where the correlation database (gwcorr.db) is to be redirected. By default, the 
correlation database is located in the domain\wpgate\notes directory. For information about the 
correlation database, see “Enabling Message Status for Sent Items” on page 62.

Syntax:
/corr-[drive:]\directory
/corr-\\server\sharename\directory

Example:
/corr-\lngate\statcorr
/corr-m:\lngate\statcorr
/corr-\\server2\c$\lngate\statcorr

/group
Turns on group expansion. If enabled, an incoming message addressed to a public group 
(distribution list) will be sent to members of that group. Group expansion is on by default.

Syntax:
/group

/help
Displays information about the Notes Gateway switches.

Syntax:
/help

/home
Specifies the path to the gateway root directory (domain\wpgate\notes). 

IMPORTANT: You cannot move the Notes Gateway software to a different location.

Syntax:
/home-[drive:]\directory
/home-\\server\sharename\directory

Example:
/home-\lngate\work
/work-m:\lngate\work
/work-\\server2\c$\lngate\work

/httppassword
Specifies the password for the Notes Gateway to prompt for before allowing gateway status 
information to be displayed in your Web browser. Do not use an existing Novell® eDirectoryTM 
password because the information passes over the insecure connection between your Web browser 
and the Notes Gateway. See “Using the Notes Gateway Web Console” on page 68.
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Syntax:
/httppassword-password

Example:
/httppassword-GWiseNotes

See also /httpuser, /httpport, and /httprefresh.

/httpport
Sets the HTTP port number used for the Notes Gateway to communicate with your Web browser. 
The setting must be unique on the machine where the Notes Gateway runs. See “Using the Notes 
Gateway Web Console” on page 68.

Syntax:
/httpport-port_number

Example:
httpport-7175

See also /httpuser, /httppassword, and /httprefresh.

/httprefresh
Specifies the rate at which the Notes Gateway refreshes the status information in your Web 
browser. The default is 60 seconds. See “Using the Notes Gateway Web Console” on page 68.

Syntax:
/httprefresh-seconds

Example:
/httprefresh-30

See also /httpuser, /httppassword, and /httpport.

/httpuser
Specifies the username for the Notes Gateway to prompt for before allowing gateway status 
information to be displayed in a Web browser. Providing a username is optional. Do not use an 
existing eDirectory username because the information passes over the insecure connection 
between your Web browser and the Notes Gateway. See “Using the Notes Gateway Web Console” 
on page 68.

Syntax:
/httpuser-username

Example:
/httpuser-GateWatcher

/ic
Specifies the Internet Agent to use for Internet connectivity. If no Internet Agent is provided, the 
Notes Gateway uses the Notes Internet connector for sending messages from Notes users to 
Internet users. See “Configuring Internet Connectivity” on page 63.
86   GroupWise Gateway 3.0 for Lotus Notes Installation and Administration Guide



    Novell Confidential                                                                                            Manual (ENU)  15 April 2004
Syntax:
/ic-domain_name.agent_name

Example:
/ic-Connector.GWIA

/lnsmb
Specifies the name of the Notes mailbox used to transfer messages between systems. The default 
is mail.box. The variable n can range from 1 to 10.

Syntax:
/lnsmb-mailn.box

Example:
/lnsmb-mail2.box

/log
Redirects the log files to the specified directory. By default, the log files are created in the 
domain\wpgate\notes\000.prc directory. See “Using Notes Gateway Log Files” on page 74.

Syntax:
/log-[drive:]\directory
/log-\\server\sharename\directory

Example:
/log-\lngate\logs
/log-m:\lngate\logs
/log-\\server2\c$\lngate\logs

See also /loglevel, /logdays, and /logmax.

/logdays
Overrides the maximum log file age specified in ConsoleOne. Any log files older than the number 
of days you specify are deleted. The range is from 1 to 360 days. See “Using Notes Gateway Log 
Files” on page 74.

Syntax:
logdays-days

Example:
/logdays-30

See also /log, /loglevel, and /logmax.

/loglevel
Overrides the log level specified in ConsoleOne. Possible options are Off, Normal, Verbose, and 
Diagnostic. See “Using Notes Gateway Log Files” on page 74.

Syntax:
/loglevel-level
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Example:
/loglevel-verbose

See also /log, /logdays, and /logmax.

/logmax
Overrides the maximum log file disk space specified in ConsoleOne. If the maximum disk space 
limit is reached, the oldest log file is deleted to make room for a new one. Specify the number of 
kilobytes you want to use. The default is 1024 KB or 1 MB. The range is from 256 KB to unlimited 
size. Use 0 for unlimited disk space. See “Using Notes Gateway Log Files” on page 74.

Syntax:
/logmax-kilobytes

Example:
/logmax-2048

See also /log, /loglevel, and /logdays.

/noalias
Specifies whether the Notes Gateway should use the Notes user’s full name (first name and last 
name) or the user’s short name (typically first initial plus last name or "alias"). By default, the 
gateway uses the short name. Use of the switch causes the gateway to use the full name.

Syntax:
/noalias

/rt
Specifies the number of receiver threads that the Notes Gateway should start. The default it 4. 
There is no limit to the number of threads you can start, but nothing is gained by starting threads 
that are always idle. See “Adjusting the Number of Sender and Receiver Threads” on page 80.

Syntax:
/rt-threads

Example:
/rt-3

See also /st.

/single
Instructs the gateway to run for one send/receive cycle, then shut down. For information about the 
send/receive cycle, see “Adjusting the Gateway’s Send/Receive Cycle” on page 79.

Syntax:
/single
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/st
Specifies the number of sender threads that the Notes Gateway should start. The default it 4. Valid 
values range from 1 to 4. See “Adjusting the Number of Sender and Receiver Threads” on page 80.

Syntax:
/st-threads

Example:
/st-3

See also /rt.

/work
Indicates the path where temporary files are stored while messages are transferred. You can use a 
path to a location on the Windows machine where the gateway is running or on the server where 
the domain directory is located. For more information, see “Reducing Network Traffic” on 
page 82.

Syntax:
/work-[drive:]\directory
/work-\\server\sharename\directory

Example:
/work-\lngate\work
/work-m:\lngate\work
/work-\\server2\c$\lngate\work
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A Notes Gateway Error Messages

This section helps you resolve error messages that appear in Notes Gateway log files and other 
places where gateway status information is displayed:

“Alphabetical Error List” on page 91

Additional sources of troubleshooting assistance include:

Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp)

GroupWise 6.x Support Forums (http://support.novell.com/forums/gw6.html)

GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

Alphabetical Error List
Error accessing VIM link
Error creating Address Book ’WPNAMES.NSF’. You are not authorized to perform that operation
Error opening character set translation file
Error processing attachment: attachment_name. You are not authorized to perform that operation
Error processing Notes Address Book information; You are not authorized to use the remote 

console on the server
Error reading character set translation file
Error synchronizing modified Notes user to GroupWise; Unsupported datatype in Name and 

Address Book document
File object is truncated; file may have been damaged
Foreign Domain missing or not configured in Name and Address Book
Invalid name for foreign domain
Invalid password
Invalid password for Lotus Notes
Memory access error
Memory allocation error
No route to the gateway
NOTES.INI file cannot be found on the search path pathname
No active recipients
Path not found error
Purging expired GroupWise directory information from Notes. Error purging GroupWise users 

from Notes. Entry not found in index
Retry count exceeded
Unable to locate GWWORK directory
Unable to replicate Lotus Notes Address Book information to GroupWise. Unsupported datatype 

in Name and Address Book document
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Undeliverable file moved to: path\filename
Unknown return value
VIM init error. Directory exchange and migrate utilities inactive
You are not authorized to use the remote console on this server

Error accessing VIM link

Source: GroupWise® Notes Gateway; directory exchange and synchronization.

Possible Cause: Invalid VIM configuration; the Notes Gateway cannot access the link to the Notes system.

Action: Make sure that the Notes client is installed on the Windows machine running the gateway.

Action: Make sure that the Notes/Domino server is running.

Error creating Address Book ’WPNAMES.NSF’. You are not authorized to perform that operation

Source: GroupWise Notes Gateway; initial startup.

Possible Cause: The Notes Gateway user is not provided with access rights to create databases on the Notes/
Domino server that the gateway communicates with. Therefore, the gateway cannot start and 
cannot create the Notes Address Book where GroupWise user information will be stored.

Action: The Notes Gateway user should be provided with access rights to create databases on the Notes/
Domino server that the gateway communicates with. See “Providing Access to Notes Databases” 
on page 32. 

After giving access rights, restart the Notes/Domino server before starting the gateway. 

Error opening character set translation file

Source: GroupWise Notes Gateway; startup.

Possible Cause: The gateway is not able to find the path to the notes and notes\data directories where the character 
set translation file is located.

Action: Make sure that the notes and notes\data directories are included in the system path on the machine 
running the Notes client for the gateway. See “Adding the Notes Software Directory to the Path 
Variable” on page 25.

Error processing attachment: attachment_name. You are not authorized to perform that operation

Source: GroupWise Notes Gateway; outbound messaging.

Possible Cause: The gateway is not able to process the attachment in a message addressed to a Notes user from 
GroupWise.

Action: None. The Gateway drops an attachment if it cannot process it and continues with processing of 
remaining part of the message.

Error processing Notes Address Book information; You are not authorized to use the remote console 
on the server

Source: GroupWise Notes Gateway; directory exchange

Possible Cause: The Notes Gateway user is not provided with the required access rights.

Action: Make sure that the Notes Gateway user is listed as an Administrator on the Notes/Domino server 
that the gateway communicates with. See “Providing Access to the Notes/Domino Server” on 
page 30.
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Error reading character set translation file

Source: GroupWise Notes Gateway; startup.

Possible Cause: The gateway is not able to find the path to the notes and notes\data directories. 

Action: Make sure that the notes and notes\data directories are included in the system path on the machine 
running the Notes client for the gateway. See “Adding the Notes Software Directory to the Path 
Variable” on page 25.

Error synchronizing modified Notes user to GroupWise; Unsupported datatype in Name and Address 
Book document

Source: GroupWise Notes Gateway; directory exchange and synchronization.

Possible Cause: The Notes Gateway user is not provided with the required access rights.

Action: Give access rights as described in “Setting Up Server and Database Access for the Notes Gateway 
User” on page 30.

File object is truncated; file may have been damaged

Source: GroupWise Notes Gateway; general processing.

Possible Cause: The wpnames.nsf file on Notes/Domino server connected to GroupWise is damaged and the 
gateway is not able to find the People view in the Notes version of the GroupWise Address Book 
(wpnames.nsf).

Action: Replace the damaged wpnames.nsf database on the Notes/Domino server with the backup copy 
that is populated with GroupWise addresses. 

Action: If you don't have a backup copy of wpnames.nsf, follow the steps:

1 Delete the damaged wpnames.nsf database on the Notes/Domino server connected to the 
gateway. 

If your Notes system is configured to replicate the wpnames.nsf file to multiple servers, delete 
it from all the Notes/Domino servers. 

2 Delete the 000.prc directory from the gateway home directory, after making copies of the log 
files if necessary.

3 From the gateway root directory, copy the wpnames.nsf database to the domino\data directory 
on the Notes/Domino server that the Notes Gateway communicates with.

4 Do a fresh directory exchange.

If the Notes Gateway is running as an application, use Actions > Synchronize Directories at 
the Notes Gateway console.

If the Notes Gateway is running as a service, the directory exchange will occur during the 
regular nightly exchange, as described in “Enabling Directory Synchronization and 
Exchange” on page 45.

5 If required by your Notes system configuration, replicate wpnames.nsf to other Notes/
Domino servers. 
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Foreign Domain missing or not configured in Name and Address Book

Source: GroupWise Notes Gateway; initialization.

Possible Cause: The gateway cannot find the foreign domain that represents the GroupWise system in the Notes 
system.

Action: Create a foreign domain for the GroupWise system on the Notes/Domino server. See “Defining the 
GroupWise System As a Notes Foreign Domain” on page 26

Action: Make sure the Foreign ID field on the Identification page of the Notes Gateway object in 
ConsoleOne matches the Foreign Domain name for the GroupWise system in the Notes system. 
See “Providing Gateway Information” on page 35 and “Defining the GroupWise System As a 
Notes Foreign Domain” on page 26.

Invalid name for foreign domain

Source: GroupWise Notes Gateway; directory exchange.

Possible Cause: Directory exchange has been enabled, but no foreign (non-GroupWise) domain has been specified 
in the Required Parameters page in ConsoleOne®.

Action: See “Enabling Directory Synchronization and Exchange” on page 45

Invalid password

Source: GroupWise Notes Gateway; startup.

Possible Cause: The Notes ID password entered on the Required Parameters page of the Notes Gateway object in 
ConsoleOne is not correct.

Action: See “Setting Required Parameters” on page 36.

Invalid password for Lotus Notes

Source: GroupWise Notes Gateway; initialization.

Possible Cause: The password specified on the Required Parameters page of the Notes Gateway object in 
ConsoleOne is not the same as the password for the Notes Gateway user.

Action: Make sure that the Notes ID Password field on the Required Parameters page of the Notes 
Gateway object in ConsoleOne is same as the Notes Gateway user password. See “Setting 
Required Parameters” on page 36 and “Registering the Notes Gateway As a Notes User” on 
page 28.

Memory access error

Source: GroupWise Notes Gateway; general processing.

Possible Cause: The gateway requires more memory than is currently available.

Action: Free up memory on the Windows machine.

Memory allocation error

Source: GroupWise Notes Gateway; general processing.

Possible Cause: The gateway requires more memory than is currently available.

Action: Free up memory on the Windows machine.
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No route to the gateway

Source: Notes client; sending a message to a GroupWise user through the Notes Gateway.

Explanation: When a Notes user tries to initiate a mail message to a GroupWise user, or if the Notes user replies 
to a GroupWise message, this message is displayed in the Notes client, and the message does not 
get delivered.

Possible Cause: The Notes/Domino Gateway Server Name field for the foreign domain document on the Notes/
Domino server is not hierarchical.

Action: In the Foreign Domain Document in the Notes/Domino Administrator, edit the Gateway Server 
Name field so that it contains the full hierarchical name of the Notes/Domino server that routes the 
messages to the Notes Gateway. See “Defining the GroupWise System As a Notes Foreign 
Domain” on page 26.

NOTES.INI file cannot be found on the search path pathname

Source: GroupWise Notes Gateway; initialization.

Possible Cause: The gateway cannot find the notes.ini file in the system path on the machine running the gateway.

Action: Include the directory containing notes.ini in the system path. See “Adding the Notes Software 
Directory to the Path Variable” on page 25.

No active recipients

Source: GroupWise Notes Gateway; outbound messaging.

Possible Cause: The message did not include the address of any active recipients.

Action: Select users from the GroupWise Address Book, rather than trying to type names in the To field.

Path not found error

Source: GroupWise Notes Gateway; startup.

Possible Cause: Invalid file path. 

Action: Make sure the gateway has network access and rights to the GroupWise domain directory, Notes/
Domino server, and any directories to which you have redirected files. See “Meeting Installation 
Prerequisites” on page 20 and Chapter 10, “Using Notes Gateway Startup Switches,” on page 83.

Purging expired GroupWise directory information from Notes. Error purging GroupWise users from 
Notes. Entry not found in index

Source: GroupWise Notes Gateway; directory exchange.

Possible Cause: The Notes version of the GroupWise Address Book (wpnames.nsf) on the Notes/Domino server 
that the Notes Gateway communicates with is damaged and gateway is not able to find the People 
view in the wpnames.nsf file.

Action: Replace the damaged wpnames.nsf database on the Notes/Domino server with a backup copy of 
wpnames.nsf that is populated with GroupWise addresses. 

Action: If you don't have a backup copy of wpnames.nsf, follow the steps:

1 Delete the damaged wpnames.nsf database on the Notes/Domino server connected to the 
gateway. 
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If your Notes system is configured to replicate the wpnames.nsf file to multiple servers, delete 
it from all the Notes/Domino servers. 

2 Delete the 000.prc directory from the gateway home directory, after making copies of the log 
files if necessary. 

3 From the gateway root directory, copy the wpnames.nsf database to the domino\data directory 
on the Notes/Domino server that the Notes Gateway communicates with.

4 Do a fresh directory exchange.

If the Notes Gateway is running as an application, use Actions > Synchronize Directories at 
the Notes Gateway console.

If the Notes Gateway is running as a service, the directory exchange will occur during the 
regular nightly exchange, as described in “Enabling Directory Synchronization and 
Exchange” on page 45.

5 If required by your Notes system configuration, replicate wpnames.nsf to other Notes/
Domino servers. 

Retry count exceeded

Source: GroupWise Notes Gateway; server connection.

Possible Cause: The gateway's attempt to reconnect to the GroupWise domain directory or Notes/Domino server 
has failed the number of times specified on the Optional Gateway Settings page in ConsoleOne.

Action: See “Automating Network Reattachment” on page 81 for more information about network 
reattachment.

Unable to locate GWWORK directory

Source: GroupWise Notes Gateway; general processing.

Possible Cause: The gateway cannot find the gwwork directory. 

Action: Make sure that connections between the Notes Gateway, the GroupWise system, and the Notes 
system are up and functioning.

Action: Verify the path specified for the /work startup switch in the notes.cfg file.

Unable to replicate Lotus Notes Address Book information to GroupWise. Unsupported datatype in 
Name and Address Book document

Source: GroupWise Notes Gateway; directory exchange.

Possible Cause: The Notes Gateway user is not provided with the required access rights. 

Action:  Make sure that the Notes Gateway user has the required access rights. See “Setting Up Server and 
Database Access for the Notes Gateway User” on page 30.

Undeliverable file moved to: path\filename

Source: GroupWise Notes Gateway; outbound messaging.

Possible Cause: The gateway repeatedly failed on an outbound message.

Action: The file was moved to the domain\wpgate\notes\gwprob directory. No action is required.

If you want to be notified when messages are moved to the gwprob directory, use the /badmsg 
startup switch and establish a postmaster, as described in “Establishing Gateway Administrators” 
on page 61. 
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Unknown return value

Source: GroupWise Notes Gateway; general processing.

Possible Cause: An uncommon error occurred.

Action: Record the conditions under which you encountered the error. For the latest error message 
solutions, look up the error message in the Novell Support Knowledgebase (http://
support.novell.com/search/kb_index.jsp).

VIM init error. Directory exchange and migrate utilities inactive

Source: GroupWise Notes Gateway; initialization.

Possible Cause: The gateway is running on the same machine as the Notes/Domino server.

Action: For the gateway to perform directory synchronization and exchange with some versions of Notes, 
the gateway must run on a machine other than the Notes/Domino server. See Chapter 2, “Notes 
Gateway System Requirements,” on page 13.

Action: Make sure that the Notes ID Password field in ConsoleOne is same as the Notes Gateway user 
password. See “Setting Required Parameters” on page 36 and “Registering the Notes Gateway As 
a Notes User” on page 28

Action: If the problem still persists, restart both the Notes/Domino server and the gateway.

You are not authorized to use the remote console on this server

Source: GroupWise Notes Gateway; initial startup.

Possible Cause: The Notes Gateway user is not listed as an administrator for the Notes/Domino server that the 
Notes Gateway communicates with

Action: Make the Notes Gateway user an administrator of the Notes/Domino server. See “Providing 
Access to the Notes/Domino Server” on page 30.
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B Notes Gateway Directory Structure

The following directory structure diagrams help you understand the Notes Gateway:

“Domino Server Directory Structure for Lotus Notes 5.x and 6.x” on page 99

“Notes Server Directory Structure for Lotus Notes 4.x” on page 100

“Notes Gateway Machine Directory Structure” on page 101

“Notes Gateway Directory Structure under the Domain” on page 102

Domino Server Directory Structure for Lotus Notes 5.x and 6.x
When you run the Notes Gateway, it accesses some standard Lotus Notes 5.x or 6.x files. It also 
creates and updates some files in the Notes system.

If you are using Lotus Notes 4.x, see “Notes Server Directory Structure for Lotus Notes 4.x” on 
page 100.

lotus directory
The lotus directory on the Domino server is the root directory for a Lotus Notes 5.x or 6.x system.

domino directory
The domino directory contains subdirectories and files pertaining to the Domino server. Lotus 
Notes 5.x and 6.x include the Domino server. Lotus Notes 4.x does not.

 lotus Lotus Notes root directory

 domino

 notes.ini file

Directory for Domino server files

Domino server initialization file

 data

 names.nsf

 wpnames.nsf

 notesgateway.nsf

Data directory for the Domino server

Notes public Address Book

Notes version of the GroupWise® Address Book

Notes mail file (mailbox) for the Notes Gateway foreign domain
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notes.ini file

The notes.ini file is the Domino server initialization file used by Lotus Notes 5.x and 6.x. You must 
manually update the notes.ini file to add the Notes version of the GroupWise Address Book to the 
Notes system, as described in “Adding the GroupWise Address Book to Notes” on page 25.

data directory

The data subdirectory contains files used by the Domino server.

names.nsf file

The names.nsf file is the Notes public Address Book.

wpnames.nsf file

The wpnames.nsf file is the Notes version of the GroupWise Address Book that is accessed by 
Notes users when sending messages to GroupWise users.

notesgateway.nsf file

The notesgateway.nsf mail file is the Notes mailbox that belongs to the Notes Gateway foreign 
domain. It is used for communication between the Notes system and the GroupWise system. See 
“Defining the GroupWise System As a Notes Foreign Domain” on page 26.

Notes Server Directory Structure for Lotus Notes 4.x
When you run the Notes Gateway, it accesses some standard Lotus Notes 4.x files. It also creates 
and updates some files in the Notes system.

lotus directory
The lotus directory on the Notes server is the root directory for a Lotus Notes 4.x system.

notes directory
The notes directory contains subdirectories and files pertaining to the Lotus Notes 4.x server. 

 lotus Lotus Notes root directory

 notes

 notes.ini file

Directory for Notes server files

Notes server initialization file

 data

 names.nsf

 wpnames.nsf

 notesgateway.nsf

Data directory for the Notes server

Notes public Address Book

Notes version of the GroupWise Address Book

Notes mail file (mailbox) for the Notes Gateway foreign domain
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notes.ini file

The notes.ini file is the Notes server initialization file used by Lotus Notes 4.x. You must manually 
update the notes.ini file to add the Notes version of the GroupWise Address Book. See “Adding 
the GroupWise Address Book to Notes” on page 25.

data directory

The data directory contains files used by the Notes server.

names.nsf file

The names.nsf file is the Notes public Address Book.

wpnames.nsf file

The wpnames.nsf file is the Notes version of the GroupWise Address Book that is accessed by 
Notes users when sending messages to GroupWise users.

notesgateway.nsf file

The notesgateway.nsf mail file is the Notes mailbox that belongs to the Notes Gateway foreign 
domain. It is used for communication between the Notes system and the GroupWise system. See 
“Defining the GroupWise System As a Notes Foreign Domain” on page 26.

Notes Gateway Machine Directory Structure
When you run the Notes Gateway, it accesses the Notes system as the Notes Gateway user you set 
up in “Registering the Notes Gateway As a Notes User” on page 28. Therefore, the Notes Gateway 
accesses some Notes client files on the Notes Gateway machine.

lotus directory
The lotus directory on the Notes Gateway machine is the root directory for the Lotus Notes client.

notes directory
The notes directory on the Notes Gateway machine contains subdirectories and files pertaining to 
the Notes client. 

notes.ini file

The notes.ini file on the Notes Gateway machine is the Notes client initialization file. It receives 
GroupWise information from the updated notes.ini file on the Notes/Domino server so that the 
Notes client can access the Notes version of the GroupWise Address Book. See “Adding the 
GroupWise Address Book to Notes” on page 25.

 lotus Lotus Notes client directory

 notes

 notes.ini file

Directory for Notes client files

Notes client initialization file
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Notes Gateway Directory Structure under the Domain
The Notes Gateway is installed in a subdirectory of the domain it belongs to.

 domain\wpgate\notes Notes Gateway root directory

 000.prc

 mmddlog.nnn

 cmd

 gwwork

Directory for message processing

Notes Gateway log files

Not used in version 3.0 of the Notes Gateway

Working directory for processing messages

 gwhold

 qfiles

Directory for retaining delayed delivery messages

Not used in version 3.0 of the Notes Gateway

 gwprob Directory for undeliverable messages

 migrate Not used in version 3.0 of the Notes Gateway

 uninstnotes Directory for the Notes Gateway uninstallation program

 wpcsin

 0-7

MTA input queue directory

Priority queue subdirectories

 wpcsout

 notxxxx

 0-7

 problem

MTA output queue directory

Notes Gateway input queue

Priority queue subdirectories

Undeliverable messages

 readme.txt Readme file

 ngate.exe

 notes.cfg

 access.cfg

 gwcorr.*

Notes Gateway program

Notes Gateway startup file

Access control configuration file

Status message correlation database

 acct

 stat

Accounting file

Statistics file

 wpnames.nsf Notes version of the GroupWise Address Book

 gwmaint.bat Gateway maintenance batch file

 ngwln.mib Notes Gateway MIB file
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domain\wpgate\notes directory
The Notes Gateway root directory is the default location for all Notes Gateway files. During 
installation, you choose the domain where you want to install the Notes Gateway and you choose 
the name of the root directory. The default directory name is notes.

To improve performance, you can move the queue directories onto the Windows machine where 
the gateway is running, as described in “Reducing Network Traffic” on page 82.

000.prc directory

The 000.prc directory is where the Notes Gateway processes messages that are passing through the 
gateway between the GroupWise and Notes systems.

mmddlog.nnn files

The mmddlog.nnn files are the Notes Gateway log files where message routing information is 
recorded. See “Using Notes Gateway Log Files” on page 74.

gwwork directory

The gwwork directory holds temporary files used in message processing.

gwhold directory

The gwhold directory is where delayed delivery messages are held until their delivery times arrive.

gwprob directory

The gwprob directory is where the Notes Gateway places incoming message files that it cannot 
process. Using the /badmsg switch, you can configure the gateway to retain bad messages, delete 
bad messages, or send bad messages to the gateway postmaster. See “Notifying the Notes Gateway 
Administrator about Bad Messages” on page 78.

 gwngate.chm

 novell_ln.hs

 map.jhm

 *.htm

Windows help file for the Notes Gateway console

JavaHelp helpset file for Gateway Administrator snap-in help

Map file for Gateway Administrator snap-in help

Help topics for Gateway Administrator snap-in help

 gwsetup.exe

 setup.inf

Notes Gateway Installation program

Installation information file

 gwstrs.fil

 wp_ga_us.trs

Notes Gateway resource file

Installation program resource file

 *.dll Supporting Windows DLL programs
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migrate directory

In version 3.0 of the Notes Gateway, the migrate directory is not used because migration tools are 
not yet available. When the migration tools become available, you will be able to convert Notes 
mailboxes and archives into GroupWise mailboxes and archives.

uninstnotes directory

The uninstnotes directory contains the Notes Gateway uninstallation program and supporting files.

wpcsin directory

The wpcsin directory is the MTA input queue where the Notes Gateway places messages from 
Notes users for transfer into the GroupWise system. When a new message arrives, the MTA for 
the domain where the gateway is installed routes it to the appropriate destination. The wpcsin 
directory in the Notes Gateway directory is parallel to the wpcsin directory in the domain. See 
“Domain Directory” in the GroupWise 6.5 Troubleshooting 3: Message Flow and Directory 
Structure for more information.

The MTA input queue contains eight priority subdirectories.

0-7 priority directories

The 0-7 priority subdirectories in the MTA input queue handle different types of messages 
transferring from the Notes system into the GroupWise system.

0: Busy searches from Notes users on GroupWise users

1: Not used by the Notes Gateway

2: High priority messages from Notes users to GroupWise users

3: Status messages notifying Notes users about the status of high priority messages sent to 
GroupWise users

4: Normal priority messages from Notes users to GroupWise users

5: Status messages notifying Notes users about the status of normal priority messages sent to 
GroupWise users 

6: Low priority messages from Notes users to GroupWise users

7: Status messages notifying Notes users about the status of low priority messages sent to 
GroupWise users 

Status message correlation must be enabled in order for Notes users to receive status information 
about messages sent to GroupWise users. See “Enabling Message Status for Sent Items” on 
page 62.

wpcsout directory

The wpcsout directory is the MTA output queue where the MTA for the domain where the gateway 
is installed places messages for transfer over to the Notes system. 

notxxxx directory

The notxxxx directory contains eight priority subdirectories.
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0-7 priority directories
The 0-7 priority subdirectories in the MTA output queue handle different types of messages 
transferring from the GroupWise system into the Notes system.

0: Busy searches from GroupWise users on Notes users

1: Not used by the Notes Gateway

2: High priority messages from GroupWise users to Notes users

3: Status messages notifying GroupWise users about the status of high priority messages sent 
to Notes users 

4: Normal priority messages from GroupWise users to Notes users

5: Status messages notifying GroupWise users about the status of normal priority messages 
sent to Notes users 

6: Low priority messages from GroupWise users to Notes users

7: Status messages notifying GroupWise users about the status of low priority messages sent 
to Notes users 

Status message correlation must be enabled in order for GroupWise users to receive status 
information about messages sent to Notes users. See “Enabling Message Status for Sent Items” on 
page 62.

problem directory

The problem directory is where the MTA places message files that it cannot deliver into one of the 
eight priority subdirectories, perhaps because the message files have been damaged.

readme.txt file

The readme.txt file describes issues and limitations of the Notes Gateway.

ngate.exe file

The ngate.exe file is the Notes Gateway executable file. You run this program to start the Notes 
Gateway. See “Starting the Notes Gateway” on page 39.

notes.cfg file

The notes.cfg file is the Notes Gateway startup file where you can use startup switches to configure 
the Notes Gateway. See Chapter 10, “Using Notes Gateway Startup Switches,” on page 83.

access.cfg file

The access.cfg file is the Notes Gateway access control file where you can control access through 
the gateway. See “Controlling Gateway Access” on page 51.

acct file

The acct file is the accounting file where information about messages passing through the gateway 
is recorded. See “Setting Up Accounting” on page 58.
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stat file

The stat file is the gateway statistics file that contains the statistics information displayed on the 
Notes Gateway console. See “Using the Notes Gateway Console” on page 65.

gwcorr.* files

The gwcorr.db file is the message status correlation database that enables message status 
information to be exchanged between GroupWise users and Notes users. See “Enabling Message 
Status for Sent Items” on page 62.

The gwcorr.dc file is the data dictionary file from which the gwcorr.db file is created.

wpnames.nsf file

The wpnames.nsf file is the Notes version of the GroupWise Address Book. It is initially created 
in the domain\wpgate\notes directory during installation and is then copied to the 
\lotus\domino\data directory (for Lotus Notes 5.x and 6.x) or the \lotus\notes\data directory (for 
Lotus Notes 4.x) when directory synchronization and exchange are enabled. See “Enabling 
Directory Synchronization and Exchange” on page 45.

gwmaint.bat file

The gwmaint.bat file is run by the Notes Gateway each night to perform whatever server 
maintenance tasks you place in it. See “Setting Up Daily Maintenance Tasks” on page 82.

ngwln.mib file

The ngwln.mib file is used if you configure the Notes Gateway for SNMP. See “Using SNMP 
Monitoring Programs” on page 75.

gwngate.chm file

The gwngate.chm file is the Windows help file that is available from the Notes Gateway console.

novell_ln.hs file

The novell_ln.hs file is the JavaHelp helpset file for the Notes Gateway help available in 
ConsoleOne®.

map.jhm file

The map.jhm file is the JavaHelp map file that maps contexts to Notes Gateway help topics in 
ConsoleOne.

*.htm files

The *.htm files are the Notes Gateway help topics that are available in ConsoleOne.

gwsetup.exe file

The gwsetup.exe file is the Notes Gateway Installation program that is automatically called by 
setuplngw.exe, the self-extracting executable file that you download from the Novel Product 
Downloads Web site (http://download.novell.com/filedist/pages/PublicSearch.jsp).
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setup.inf file

The setup.inf file contains information used by the Installation program.

gwstrs.fil file

The gwtrs.fil file is the strings resource file used by the Notes Gateway console on the Windows 
machine where the gateway runs.

wp_ga_us.trs file

The wp_ga_us.trs file is the strings resource file used by the Notes Gateway Installation program.

*.dll files

The *.dll files are supporting programs that provide specialized functionality to the Notes 
Gateway.
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C Documentation Updates

This section lists updates to the Notes Gateway Installation and Administration Guide that have 
been made since the initial release of the Notes Gateway 3.0. The information helps you to keep 
current on documentation updates and, in some cases, software updates (such as a Support Pack 
release).

The information is grouped according to the date when the Notes Gateway Installation and 
Administration Guide was republished. Within each dated section, the updates are listed by the 
names of the main table of contents sections.

The Notes Gateway Installation and Administration Guide has been updated on the following 
dates:

“July 16, 2004” on page 109

July 16, 2004

Location Change

Chapter 2, “Notes Gateway 
System Requirements,” on 
page 13

Changed the supported version of Notes from 6.x  to 6.0.x. Version 6.5 
is not supported for use with the GroupWise® Notes Gateway.
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